‘? TEXAS
INSTRUMENTS

C28x™ Digital Power Supply Workshop

Workshop Guide and Lab Manual

C28xdps O
Revision 1.1

May 2008 ) -
Technical Training
Organization



Workshop Topics

Important Notice

Texas Instruments and its subsidiaries (T1) reserve the right to make changes to their products or to
discontinue any product or service without notice, and advise customers to obtain the latest version of
relevant information to verify, before placing orders, that information being relied on is current and
complete. All products are sold subject to the terms and conditions of sale supplied at the time of order
acknowledgment, including those pertaining to warranty, patent infringement, and limitation of liability.

TI warrants performance of its semiconductor products to the specifications applicable at the time of sale in
accordance with TI’s standard warranty. Testing and other quality control techniques are utilized to the
extent Tl deems necessary to support this warranty. Specific testing of all parameters of each device is not
necessarily performed, except those mandated by government requirements.

Customers are responsible for their applications using Tl components.

In order to minimize risks associated with the customer’s applications, adequate design and operating
safeguards must be provided by the customer to minimize inherent or procedural hazards.

T1 assumes no liability for applications assistance or customer product design. T1 does not warrant or
represent that any license, either express or implied, is granted under any patent right, copyright, mask
work right, or other intellectual property right of TI covering or relating to any combination, machine, or
process in which such semiconductor products or services might be or are used. TI’s publication of
information regarding any third party’s products or services does not constitute T1’s approval, warranty or
endorsement thereof.

Copyright © 2008 Texas Instruments Incorporated

Revision History
January 2008 — Revision 1.0
May 2008 — Revision 1.1

Mailing Address

Texas Instruments

Training Technical Organization
7839 Churchill Way

M/S 3984

Dallas, Texas 75251-1903

2 C28x Digital Power Supply Workshop



Workshop Topics

Workshop Topics

Lo G o) o] oSSR 3
WOIKSNOP OULIINE ...ttt e et re e ne e s e e e e aeseenaeseeaneareeneeneeneens 4
1 — Introduction to Digital POWEr SUPPIY DESIGN.......ccueiiiiiiieeiieeeieie sttt 5
What is @ Digital POWET SUPPIY?......oiiieii ittt sttt ne e 5
Why use Digital Control TECANIGUES?........cviiiie ittt sttt 6
Peripherals used for Digital Power SUPPIY DESIGN........ccuiiriiiiiiiiii st 10
Development TOOIS and SOTIWAIE ........c.eiiiiiieiiie et nee 12
Labl: Exploring the Development ENVIFONMENL............cociiiiiiiiiiieiene e 16
2 — Driving the Power Stage with PWM Waveforms ..........cccccieiiiiiine e 24
Open-Loop System BIOCK DIagram..........ccceviiiieiiiieiieieiece st e et st sre s 24
Generating PWM using the ePWIM MOAUIE.............cooviiiiiicccses e 25
Power Stage Topologies and Software Library SUPPOIt.........cccooviiiiiviiciiece s 28
Lab2: PWM Generation / Open-Loop CONLIOL ........ccviiieiiiiieee e st se e et sre s neens 32
3 — Controlling the Power Stage With FEedDacK............cccoriiriiiiii s 42
Closed-Loop System BIOCK DIAGIaM ..ottt 42
ADC MOodUle BIOCK DIAGIAM ....cviiiiietiieeiete ettt sttt b et sb e ebe b nnene s 43
Digital Control of POWET CONVEITE ........couiiiiiiiiiieitt ettt st bbb enee e 43
High-Resolution PWIM BeNEFitS.........ooiiiiiiieii ettt 46
SOft Start — StArtiNg the LOOP ....cvooveie ettt e b e bbb e 47
(= o1 2 O [ =T B I o o I 90 11 1 (o] ISR 48
4 — Tuning the Loop for Good TranSient RESPONSE ........ccecveieeiieiieriesiese st sesee e seesee e sresresre e sneesaeeenes 57
Digital Power SUPPlY CoNtrol TREOIY ......ccvcieiiie et bbb te e snens 57
Intuitive Loop Tuning — “Visually Without Math” ............ccccveirieieicrcce e 59
Active Load Feature of the POWEN EVIM .......oviiiiic et 63
(=T oZZ S a1 T R (=N 1o To] o SRS 64
MUIEI-LOOP CONTIOL ...ttt bbb b bbbt bbbttt bbb 71
5 — SUMMArY and CONCIUSION ......couiiiieiiie ettt ettt ste st e stesbeereaneeseeneeneas 73
Review of WOrkshop TOPICS ANd EXEICISES .....ecvvieirieieieieiiesiesesiesieseeeeeeie e s ste et ssesneeseeneeseseens 73
T1 Digital POWEE PrOGUCES .....ccueiiiiiite ittt sttt sb et se bbbt er e e 74
C2000 Digital Signal Controller Family ... e 75
UCD9xxx Digital Power Controller FAmMily ..........ccccoiioiiiiiii e 80
Where to Find More INFOrMAation ..........ccocviiiiiiicicsc et ne e e 81

C28x Digital Power Supply Workshop 3



Workshop Outline

Workshop Outline

Workshop Outline

1. Introduction to Digital Power
Supply Design

+ Lab: Exploring the Development Environment

2. Driving the Power Stage with PWM
Waveforms

+ Lab: PWM Generation / Open-Loop Control

3. Controlling the Power Stage with
Feedback

+ Lab: Closed-Loop Control

4. Tuning the Loop for Good Transient
Response

+ Lab: Tuning the Loop
5. Summary and Conclusion
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1 — Introduction to Digital Power Supply Design

1 — Introduction to Digital Power Supply Design

Introduction to Digital Power Supply Design

L 2

What is a Digital Power Supply?

¢ Why use Digital Control
Techniques?

¢ Peripherals used for Digital Power
Supply Design

¢ Development Tools and Software

What is a Digital Power Supply?

What is Digital Power?
Generic Power System Block Diagram

lvin
.| Controller |PWM | Switches R LC Vour
”| (Compensator) g (FETs) "I Network e

The controller block is what differentiates between a digital
power system and a conventional analog power system

C28x Digital Power Supply Workshop 5



1 — Introduction to Digital Power Supply Design

Why use Digital Control Techniques?

Why Digital Control Techniques?

Controller > PWM » Power Elec.
Analog
or lf|+
Digital 27 |« Sensor(s) |e L %
Analog Controller Digital Controller
+ ¢ High bandwidth # Insensitive to environment (temp, drift,...)

# High resolution ¢ S/w programmable / flexible solution
# Easy to understand / use # Precise / predictable behavior
# Historically lower cost + Advanced control possible (non-linear, multi-variable)

¢ Can perform multiple loops and “other” functions

¢ Component drift and aging / unstable 4 Bandwidth limitations (sampling loop)
—| ® Component tolerances ¢ PWM frequency and resolution limits
& Hardwired / not flexible + Numerical problems (quantization, rounding,...)
# Limited to classical control theory only ¢ AD /DA boundary (resolution, speed, cost)
# Large parts count for complex systems ¢ CPU performance limitations

+ Bias supplies, interface requirements

Benefits of Digital Control

-fgéeg’e TP -Tlimnc
e

Inrush/ i DC/DC | (Current/Load
Hot-plu PFC Control i Converter - Sharin
Contro H Control Control

o

® Output

Traditional Analog
Power Supply

= Multiple chips for

Multi-mode control
Irggrfag:te H Power control .
ircui H e = Micro-controller for
Monitor L. MCU = prReesont | superviso
(Mcu) H Groute P v

= Dedicated design

l

—

=i
| AuxPIs

JEIiminate Components
FliI(tj%re‘ 1 Output Reduce Manufacturing Cost
Better Performance Across Corners

JOne Design, Multiple Supplies

Failure Prediction

JOne Device, Multiple DC Outputs

. . L Variable DC Output
Digital controller enables multi-threaded applications J P
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1 — Introduction to Digital Power Supply Design

Analog Control System

C(s)= R, [1+RCs
R, \1+R,C,s

Need to find:
Rll RZI Clt CZ

e C P -
R + (controller) (plant) > Y
- A A
// \ pN
"Analog Computation” \
Differential equations
c
: —I—
li R Energy
Storage
2t —W\— Elements
L
YN

dy@® ,  d’y@® _, dy@®
+k +k, +koy(t) = f(t
S Lk k() = 1)
Differential equations
It 2d 39 order

’ Laplace Transform

Digital Control System

Need to find:
ay, @z, by, by, b,

where...E(n) =R(n)-Y(n)

R E|l ¢ (UDA | P .y
+ (controller) I zoH | (plant) 4
- } T
’ AD \

/ e |[¢ )

Difference equaﬁah .
U() =a,-U(n-2)+a-Un-9+ 4'17 Erergy
by -E(n—2) +by - E(n—1)+hy - E(n) M— e

L

d’y() _, d’y@® . dy()
+k +k +koy(t) = f(t
o L ek k() = ()
Differential equations
st rd 3d | order

’ Laplace Transform ‘

OR
’ Z Transform ‘
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1 — Introduction to Digital Power Supply Design

Time Sampled Systems

Digital Processor

A-D E?—» C‘I’:tml D-A+—
+ W

\ 4

\ 4

Ref
yi(t) y(n) sample u(t)
period
T
t t t t
Continuous Discrete
time signal time signal
Processor Bandwidth
y(n)
! !
H TsampLe 4’!
]
; |
|
I |
" |
lI : e > t
i i '
Processor | Control Code | | Control Code | Control

Sample Freq PWM) Sample Period
(kHz) (ns)
100 10000
300 3333
500 2000
700 1429
1000 1000
1500 667
2000 500
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1 — Introduction to Digital Power Supply Design

Time Division Multiplexing (TDM)

Processor 1
Processor 2
Processor 3

Single CPU

n
yi ) |<7 TsampLe 4’:
e | o
| ~__ " — ~ B
H ~ ! 1
i ; : i
| B i
i i i -t
i i :
! ! i
Control Code (C1) | Control Code | Control
Control Code (C2) | Control Code | Control
Control Code (C3) | Control Code | Control
c1 [ c2 | c3 | c1 [ c2 | c3 | ci [ c2 ] cs

Digitally Controlled Power Supply

DSC

0110101100
1011011101
0010100111

“High fidelity”
Translation boundary
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1 — Introduction to Digital Power Supply Design

System Mapping

PFC - 3ph Interleaved

F280xx ‘s
< Chl o |
DSP ADC |« Ch2 o i
’|‘ —lJ‘ -Jﬁ H ]

32 bit core | o] 12 bit

Vour

YV¥Y
B
>0

oo
J1

60~100
MHz (80nS) | ® |16

;
I

Phase-Shifted Full Bridge

Vour
3A Viv YA

[an _ g
3
._lq -_IH Y 3 Y 3

3
:

%
W
12
w

Al

PAl
Y|
/1

%

Peripherals used for Digital Power Supply Design
TMS320F280x

High Performance DSP (C28x™ Core)
= 100MIPS performance
= Single cycle 32 x32-bit MAC (or dual 16 x16 MAC)

= Very Fast Interrupt Response
= Single cycle read-modified-write

Memory Sub-System
Fast program execution out of both RAM and

Flash memory
= 85 MIPS with Flash Acceleration Technology

= 100 MIPS out of RAM for time-critical code

Control Peripherals

Up to 6 ePWM, 4 eCAP, and 2 eQEP

Ultra-Fast 12-bit ADC

= 6.25 MSPS throughput

= Dual sample&holds enable simultaneous sampling
= Auto Sequencer, up to 16 conversions w/o CPU

Communications Ports

Multiple standard communication ports provide
simple interfaces to other components

64Kw Flash
+ 1Kw OTP

32x32-bit
Multiplier
Timers (3

Datasheet available at: http://www-s.ti.com/sc/ds/tms320f2808.pdf
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1 — Introduction to Digital Power Supply Design

Efficient 32-bit Processor Capability

Interrupt Management

C28x™ DSP Core

j [ Single-cycle 32-bit multiplier makes
"~ coex™a2bitDsP computationally intensive control
R-M:W algorithms more efficient
Multiplier Atomic

ALU

32-bit
Timers (3

-bit
Register

Three 32-bit timers support multiple
control loops / time bases

Single cycle read-modified-write in any
memory location and 32-bit registers

JTAG

# Instructions vs PWM

File

improve control algorithm efficiency

= Real-time JTAG debug shortens
development cycle

PWM freq. | PWM per. | Processor MIPS = Fast & flexible interrupt management
(kHz) (ns) 100 150 significantly reduce interrupt latency
50 20.0 2000 3000
100 10.0 1000 1500
200 5.0 500 750 T —*
250 4.0 400 600
300 33 333 500 PWM | |
500 2.0 200 300
750 1.3 133 200 CPU | control Codel spare| Control Code|spare Control
1000 1.0 100 150

MIPS = Million Instruction Per Second

ePWM “DAC” Capability

Control Peripherals

ePWM

= Number of channels scalable
and resources allocated per
channel

= Two independent PWM outputs
per module

= Dedicated time-base timer

= Two independent compare

PWM effective resolution (CPU=100MHZz)

PWM | Standard PWM HR-PWM registers
(kHz) bits % bits % = Multi-event driven waveform

50 11.0 0.05 17.0 | 0.0007 = Trip zones and event interrupts
100 10.0 0.10 16.0 | 0.0015 = F2808 offers 6 modules

150 9.4 0.15 154 | 0.0022 = Provides ePWM DAC capability
250 8.6 0.25 14.7 | 0.0037 for DPS

500 7.6 0.50 13.7 | 0.0075 = Switching can be programmed
70 71 075 | 131 00112 as Asymmetric or Symmetric
1000 | 6.6 1.00 12.7  0.0150 PWM

= High-Resolution PWM mode
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1 — Introduction to Digital Power Supply Design

I
Prescaler ™ SYSCLK

8 ADC
Inputs

8 ADC
Inputs

ADC Utilization:
# Channels (“Loops”) vs. PWM frequency

12-bit ADC Capability

\ Control Peripherals

Fast & Flexible
12-bit 16-Channel ADC
= 12.5 MSPS throughput

= Dual sample/hold enable
simultaneous sampling or
sequencing sampling modes

= Analog input: OV to 3V
= 16 channel, multiplexed inputs

= Auto Sequencer supports up to 16
conversions without CPU

intervention

MSPS = 3 MSPS = 6.25

PWM # Channels PWM # Channels
(kHz) (kHz)

125 24 125 50

250 12 250 25

500 6 500 13

750 4 750 8
1000 3 1000 6

= Sequencer can be operated as two
independent 8-state sequencers or
as one large 16-state sequencer

= Sixteen result registers (individually

addressable) to store conversion
values

Development Tools and Software

® [F 2808 ol daplepu, 0 - TS ™o ixx
e B Ve Pochet Debug GO Optin Profle fod
C1- 2]

Project Manager:
»Source & object files
~File dependencies :
»Compiler, Assembler &
Linker build options

Full C/C++ & Assembly
Debugging:

Code Composer Studio

Menus or Icons
-\

Cade o vposer Su;
o5 Wi

CPU
Window

Help

die

3

S
L F ]

W

= ooanoond
= QOOBO00E
= 02000000
- QOOBOCFT
- ODODFEFE
- 000

- o
= ARARARNY F

phical Display

»>C & ASM Source il
»Mixed mode i |
»Disassembly (patch) Wi o A | |
~Set Break Points S e
»Set Probe Points

How __ ____|Yén | ise i

e vz a0aD0<8D:

5:;‘m L] U2 ocf!ons:m:
Editor: o :
>Structure Expansion Ll e lal.t o | e e

Tl stant esmOE:- - B T & e ™
Status Watch Window Graph Memory Window
Window Window
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1 — Introduction to Digital Power Supply Design

CNTL CNTL Buck E HR §
2P2Z 3P3Z Single | Buck |y
»{ Ref > Ref DRV |m Single [ m
> s Uoutp > fg Uoutp DRV
> Duty H L EPWMnA —» > Duty H epwmna —
Control 2-pole / 2-zero Control 3-pole/ 3-zero W W
Buck Single Output High Resolution Buck
IIR-FILT IIR-FILT
2P2Z 3P3Z L epwmiA —> PFC | E
l@ l@ I\D/[FR,I\I; E [ QPHIL VF"I
vn: - EPWM2A —» DRV
> out > In out I EPWM2B —> >y [ EPWMnA —>
H ° »>| Adj W - EPWMnB —»
2 order IR filter 3¢ order IIR filter »>{ Duty w o
L] Power Factor 2-phase
Multi-Phase Interleaved Interleaved
SinGenl SGenHP1
E
HHB | p IBM .
»| Freq »>| Freq DRV | W FB | p | EPWMNA —>
> Gain  Out P > Gain  Out P> & DRV XAV - EPWMNB —>
- EPWMnA —»
| Offset > Offset > Duty H > In |
. . — W - EPwinE —> 3 o x EPWM(n+DA >
Sine Wave generator High precision Sine Gen Half H-Bridge > DelRL - EPWM(n+1)B >
SSartSEQ IBM method Full Bridge
ég\lla PSFE 38 EPWMnA —» |« cho
o n
DRV VF\” ADC | p & cn
[ EPWMnB —» [« Ch3
> In out p | Delay N M DRV | € chs
i > si o [ - EPWMM+D)A > »
Inverse Square function ope > Llegdb ‘:‘I o Rst "’*v »
> Target | Rlegdb - EPWM(n+1)B > °
Soft Start and Sequencing Phase Shifted Full Bridge Analog-Digital Converter driver

Modular Software Architecture

“Signal Net” based module connectivity

f1

et ) in1a f4
outl Nt 3 In4A
In1B
I Nett 3] [n4B  Outd [Nt
X3 m4c
n ut
—let3 3] In2A Out2 fs

f3 —p| In5A Out5s fpNe®

Net4  _5] In3A Out3

Initialization time .

. dect Run time - ISR
pointer & Net declarations B

Int *InlA, *InlB, *Outl, *In2A,... ; Execute the code

Int Netl, Net2, Net3, Net4,...

1
// **connect” the modules 2
In1A=&Netl; Inl1B=&Net2; In2A=&Net3; In3A=&Net4; // inputs 3
Out4=&Net8; Out5=&Net9; // outputs 4
Outl=&Net5; In4A=&Net5; // Net5 f5
Out2=&Net6; In4B=&Net6; // Net6
Out3=&Net7; In4C=&Net7; In5A=&Net7; // Net7
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1 — Introduction to Digital Power Supply Design

Peripheral Drivers

CPU dependency only:

» Math / algorithms

* Per-Unit math (0-100%)
* Independent of Hardware

AL
r CNTL

£ 2P2Z

Vre

_ —— P Ref

(Q15) € Out
Fdbk

// pointer & Net declarations

« System clock frequency
| BUCK | p
N . DRV |w
M
Duty __ - WL
(le) i In W EPWMIA —»
! ADC
. SEQ1 | A
| DRV |b
chil;)t — ¢Rsi0 € le Apc r0 —
I H € ADC_ Al —
Wig ADC A2 —
l€« ADC A3 —

int *CNTL_Refl, *CNTL_Fdobk1, *CNTL_Outl;

int *BUCK_Inl, *ADC_Rsltl;
int Vref, Duty, Vout;

// *“‘connect” the modules
CNTL_Refl = &Vref;

CNTL_Outl = &Duty; BUCK_Inl = &Duty;
CNTL_Fdbkl = &Vout; ADC_Rsltl = &Vout;

/ « PWM frequency

Depends on:

\ Depends on:

* # ADC bits (10/12 ?)
* Unipolar, Bipolar ?
* Offset ?

Dual Buck Example

ISR

Voltage
Controller

CNTL
2P2Z

|

FB

400 kHz

Voltage
Controller

S-start / SEQ

CNTL
2P2Z

FB

400 kHz

Ref  Youtl—>— DutyCmd1l —>|

(REAT Uout—>»— DutyCmd2 —>

Voutl —<—

Single Power Stage

Vout2 —«—

3
BUCK VF\"
DRV |y
H
Duty W [~ EPWM1A
400 kHz
A
ADC |p
DRV |C
H
rsko0 W [«— ChO
400 kHz
E
BUCK ‘:'I
DRV |y
H
Duty W [~ EPWM2A
400 kHz
A
ADC |p
DRV |C
H
rsk0 W («— Chl

Single Power Stage

400 kHz

14
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1 — Introduction to Digital Power Supply Design

Software Block Execution

BG ISR

(400 kHz)

SStartSeq
} Context Save

CNTL_2P2Z(1)
BUCK_DRV (1)

Loop-1

> ISR body

CNTL_2P2Z(2) Loop-2
BUCK DRV (2)

Context
Restore

C28x Digital Power Supply Workshop 15



Labl: Exploring the Development Environment

Labl: Exploring the Development Environment

» Objective

The objective of this lab exercise is to demonstrate the topics discussed in this module and
become familiar with the operation of Code Composer Studio (CCS). Steps required to build and
run a project will be explored. The project will generate various PWM waveforms which will be
viewed using the CCS graphical capabilities. The slider feature in CCS will be used to adjust the
duty, phase, and dead-band values of the waveforms. Additionally, the Digital Power software
framework, associated files, and library modules will be used.

Labl: Exploring the Development Environment

¢ Navigate CCS features
¢ Understand DPS library structure
¢ Generate and visualize PWM waveforms

TI PowerTrain
PTDO8AO1OW
10A module
= Current meas.
= Temp meas
= Over Current Prot. - d
= Over Current Flag - 3] ud
* No Heat-sink needed

. Active Volt
SWI\ Phase Links Load LEDs Meter

sad

Live L
» e DOk

2 Ch Buck EWH
F2gBxx

> Project Overview

The PWMexplore project makes use of the “C-background/ASM-ISR” framework. This
framework will be used throughout all the lab exercises in this workshop. It uses C-code as the
main supporting program for the application, and is responsible for all system management tasks,
decision making, intelligence, and host interaction. The assembly code is strictly limited to the
ISR, which runs all the critical control code and typically this includes ADC reading, control
calculations, and PWM updates.

The key framework C files used in this project are:

PWMexplore-Main.c - thisfile is used to initialize, run, and manage the application. This is
the “brains” behind the application.

PWMexplore-Devinit.c - this file is responsible for a one time initialization and

configuration of the F280x device, and includes functions such as setting up the clocks, PLL,
GPIO, etc.

16
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Labl: Exploring the Development Environment

The ISR consists of a single file:

PWMexplore-1SR.asm - this file contains all time critical “control type” code. This file has
an initialization section (one time execute) and a run-time section which executes (typically) at
the same rate as the PWM timebase used to trigger it.

The Power Library functions (modules) are “called” from this framework. Library modules may
have both a C and an assembly component. In this lab exercise, six library modules (all PIWM
waveform generators or drivers) are used. The C and corresponding assembly module names are:

C configure function

ASM initialization macro

ASM run-time macro

BuckSingle _CNFQO BuckSingle DRV _INIT n BuckSingle DRV n
BuckDual CNFQO) BuckDual DRV_INIT n BuckDual DRV n
MPhIL_CNFQ) MPhIL_DRV_INIT n, N MPhIL_DRV n, N
FullBridgePS CNF() | FullBridgePS DRV_INIT n FullBridgePS DRV n
FullBridgelBM _CNFQ) | FullBridgelBM_DRV_INIT n | FullBridgelBM DRV n
PFC2PhIL_CNFQ PFC2PhIL_DRV_INIT n PFC2PhIL_DRV_INIT n
These blocks can also be represented graphically. This helps visualize the system software flow
and function input/output. The PWM driver modules used in Labl are:
Buck E Buck E
Single | Dual |
DRV | ™ DRV | M
> In Ho— PwMA — > InA y — PWMA —>
w > InB W — PWMB —»
— PWMI1A —» PFC | E
MPhIL IE L PWM2A —» 2PhIL VPV
DRV |w |- pwm3s —» DRV |m
=y PWM4A —» & In HI PWMA —»
H ° > Adj W — PWMB —»
> In w [ ]
[}
FB
F];SRF\]? E — PWMI1A —» IBM E — PWMIA —»
W — PWM1B —» DRV |W . — pwM1B —»
M M
- Phase — PWM2A —» > In — PWM2A —»
> Llegdb VI-\|I L PWM2B —» > DellL \ll-iv L PWM2B —»
- Rlegdb - DelRL
C28x Digital Power Supply Workshop 17




Labl: Exploring the Development Environment

» Lab Exercise Overview

The software in Lab1 has been configured so the user can quickly evaluate the 6 PWM driver
modules by viewing the output waveforms and interactively adjusting the duty, phase, and
deadband values. The graphing feature of CCS is used to visualize the waveform. The ADC
peripheral is configured to provide a “scope” capture function. The PWM outputs on the buck
EVM are directly connected to ADC inputs via zero ohm resistors. Collected data samples are
stored in four separate memory buffers, hence a simple 4-channel scope is realized. CCS can link
each memory buffer to a graph window and display the captured data. With the real-time feature
enabled, this data can be captured at high speed and streamed back via JTAG (at a slower rate) to
update the graph windows periodically (~200 ms update rate).

Since the PWM waveforms being sampled are essentially “square waves” (high speed edges) they
have been scaled down in frequency to approximately 10 kHz. This allows the ADC sampling to
better capture and display the edge transitions in the graph window during datalogging. As Labl
is more for visual demonstration purposes, the high speed ISR code subroutine _ISR_Run has
been allocated to datalogging. The PWM driver macros are running at a much slower update rate
from subroutine _ I SR_Pseudo, which is conveniently called directly from C. The PWM driver
macro instantiation convention however is still the same as in the more typical case where
__ISR_Run is used to execute all PWM updates and loop control. This will be the convention
used in Labs 2, 3 and 4 where an actual 2-channel buck stage will be controlled with high speed
PWM outputs.

The following diagram shows an example of how the Full Bridge Phase Shifted PWM module is
evaluated in this lab. This setup is essentially the same for all 6 cases, except the PWM driver
macro module is swapped and the appropriate sliders used to adjust the relevant timing are
selected.

PWM driver macro

|| psFB || -
Watch Window | DRV | P
W | — PWMI1B
X M 1
Phase —}—»| Phase - PWM2A
: H
_,—I—V Llegdb — PWM2B
w .
DBleft _|—> Rlegdb |
DBright DBright l_ __________ : \ 4
Y
&] [al Y
\4
et ot Gr‘aph Window Loopback
==h = : DataLogger
il i
[v] (V] MemBuf-1 Inl «— ADC
Phase Dead Dead I I I I | MemBuf-2 In2 «— ADC
slider Band Band MemBuf-3 In3 [«— ADC
Left  Right MemBuf-4 In4 l«— ADC
M |
11 [ 11
I | L J —
[ | <
[ | [ |
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Labl: Exploring the Development Environment

» Procedure

Start CCS and Open a Project

1. Move the switch SW1 to the “on” position to power the 2-channel buck EVM board.

2. Double click on the Code Composer Studio icon on the desktop. Maximize Code
Composer Studio to fill your screen. Code Composer Studio has a Connect/Disconnect
feature which allows the target to be dynamically connected and disconnected. This will
reset the JTAG link and also enable “hot swapping” a target board. Connect to the target.

Click: Debug > Connect

The menu bar (at the top) lists File ... Help. Note the horizontal tool bar below the menu
bar and the vertical tool bar on the left-hand side. The window on the left is the project
window and the large right hand window is your workspace.

3. A project contains all the files and build options needed to develop an executable output
file (. out) which can be run on the DSP hardware. A project named Labl._pjt has
been created for this lab exercise. Open the project by clicking:

Project - Open..

and look in C:\C28x_DPS\LABS\LAB1. This project (.pjt file) will invoke all the
necessary tools (compiler, assembler, linker) to build the project. It will also create a
folder that will hold immediate output files.

4. In the project window on the left, click the plus sign (+) to the left of Project. Now,
click on the plus sign next to Labl.pjt. Click on the plus sign next to Source to see
the current source file list.

5. A GEL file can be used to create a custom GEL menu and automate steps in CCS. A
GEL file which will setup sliders has been created for this lab exercise. The slider will be
used to adjust the duty, phase, and dead-band values of the waveforms. Load the
PWMexplore_.gel file by clicking:

File > Load Gel..

and look in C:\C28x_DPS\LABS\LABL1.

Device Initialization, Main, and ISR Files

Note: DO NOT make any changes to the source files — ONLY INSPECT

6. Open and inspect PWMexplore-DevInit.c by double clicking on the filename in the
project window. Notice that system clock, peripheral clock prescale, and peripheral
clock enables have been setup. Next, notice that the shared GPIO pins have been
configured.
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7.

Open and inspect PWMexplore-Main_.c. Notice the background for(; ;) loop and
the case statements. This is where each of the PWM configuration functions are called
for the 6 cases previously described. The case statement provides a convenient way to
showcase each PWM driver quickly and interactively for demonstration purposes.

Open and inspect PWMexplore-1SR.asm. Notice the ISR_Initand

__ ISR _Pseudo sections. This is where the PWM driver macro instantiation is done for

initialization and runtime, respectively. Optionally, you can close the inspected files.

Build and Load the Project

9.

10.

11.

12.

The top four buttons on the horizontal toolbar control code generation. Hover your
mouse over each button as you read the following descriptions:

Button Name Description
1 Compile File Compile, assemble the current open file
2 Incremental Build Compile, assemble only changed files, then link
3 Rebuild All Compile, assemble all files, then link
4 Stop Build Stop code generation

Code Composer Studio can automatically load the output file after a successful build. On
the menu bar click: Option > Customize.. and select the
“Program/Project/CI0” tab, check ““Load Program After Build”.

Also, Code Composer Studio can automatically connect to the target when started. Select
the “Debug Properties” tab, check “Connect to the target at
startup”, then click OK.

Click the ““Rebui Id Al 1’ button and watch the tools run in the build window. The
output file should automatically load.

Under Debug on the menu bar click “Reset CPU”, “Restart”, and then “Go
Main’. You should now be at the start of Main().

Debug Environment Windows

It is standard debug practice to watch local and global variables while debugging code. There
are various methods for doing this in Code Composer Studio, such as memory windows and
watch windows. Additionally, Code Composer Studio has the ability to make time (and
frequency) domain plots. This allows us to view waveforms using graph windows. We will
use two of them here: watch windows and graph windows.

13.

Open the watch window to view the variables used in the project.
Click: View > Watch Window on the menu bar.

Click the “Watch 1" tab at the bottom of the watch window. In the empty box in the
"Name" column, type the symbol name “ConfigOption” and press enter on
keyboard. Next add the following other symbol names: ““Dutyl1”’, “Duty2”,

20
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“Phase”, “DbLeft”, and ““DbRight”. The watch window should look something

like:

A Watch Window

MHane Walue Type | Radix J

& ConfigOption | O | Uint16 | unzigned
@ Dutyl 1] | Int16 | dec
@ Dut2 o | Int16 | dec
% Phase o | Int16 | dec
& Dbleft 0 | int1B | dec
& DbRight I |int16 | dec:

2 |

&, latch Locals 57 watch 1

14. Open and setup two dual time graph windows to plot the four data log buffers A, B, C

and D (ADC result registers). Click: View = Graph -> Time/Frequency.. and
set the following values:

= Graph Property Dialog

Dizgplay Type
Graph Title:
Irtereaved Data Sources

DSP Data Type
O-value
Sampling Rate [Hz)

Dual Tinve
Data Log Buffer & & B
Mo

16-bit signed integer
i]
1

oK | Cancel‘

Help |

& Graph Property Dialog

Digplay Type
Graph Title:
Interleaved Data Sources

DSP Data Type
Q-value
Sampling Fate [Hz)

Dual Time
Data Log Buffer C& D
Mo

Start Addresz - upper display DLogB ufferd, Start Address - upper display DLogBufferC
Start Address - lower display DLogB ufferB Start Address - lower display DLogBufferD
FPage Data Page Data
Acquisition Buffer Size 200 Acquisition Buffer Size 200

Index Increment 1 Index Increment 1

Display Data Size 200 Dizplay Data Size 200

16-bit zigned integer
1]
1

Flat O ata Fram Left to Right Flot D ata Fram Left ta Right
Left-shifted D ata Dizplay Ve Left-shifted Drata Display YVes
Autoscale o Autoscale O

DC Walue 1] DC Yalue 1]

P awirmum Y- value 20000 b airmum Y-walue 20000
Axes Display uli} Awes Dizplay uli}

Time Digplay Unit 3 Time Digplay Unit ]

Statuz Bar Display On Statuz Bar Display On
Magnitude Dizplay Scale Lirear Magnitude Display Scale Linear

D ata Plat Style Like Data Plot Style Line

Grid Style Zera Line Grid Shyle Zero Line
Cursor Mode Mo Curgar Cursor Mode Ma Cursor

oK | Cancel|

Help |

Select OK to save the graph options.

Saving the Workspace Environment

The workspace contains all of the elements that make up the current Code Composer Studio
working environment. These elements include the project, project settings, configuration settings,
and windows such as watch window and graphs. A workspace can be saved in a workspace file
(*.wks) and reloaded at a later time. This is very useful for a subsequent Code Composer Studio
session, or if a problem occurs and the tools need to be reset.

15. Save the current workspace by naming it Labl .wks and clicking:

File > Workspace - Save Workspace As..
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and saving in C:\C28x_DPS\LABS\LAB1.
When needed, a workspace can be loaded by clicking:
File > Workspace > Load Workspace..

and looking in the saved location.

Using Real-time Emulation

Real-time emulation is a special emulation feature that allows the windows within Code
Composer Studio to be updated at up to a 10 Hz rate while the DSP is running. This not only
allows graphs and watch windows to update, but also allows the user to change values in
watch or memory windows, and have those changes affect the DSP behavior. This is very
useful when tuning control law parameters on-the-fly, for example.

16. Enable real-time mode by selecting:
Debug - Real-time Mode

17. A message box may appear. If so, select YES to enable debug events. This will set bit 1
(DGBM bit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit.
When the DGBM bit is set to “0”, memory and register values can be passed to the host
processor for updating the debugger windows.

18. The graph windows should be open. In real-time mode, we would like to have our
window continuously refresh. Click:

View > Real-time Refresh Options..

and check “Global Continuous Refresh”. Use the default refresh rate of 100
ms and select OK. Alternately, we could have right clicked on each window individually
and selected ““Continuous Refresh”.

Note: “Global Continuous Refresh™ causes all open windows to refresh at the
refresh rate. This can be problematic when a large number of windows are open, as
bandwidth over the emulation link is limited. Updating too many windows can cause the
refresh frequency to bog down. In that case, either close some windows, or disable
global refresh and selectively enable “Continuous Refresh” for individual
windows of interest instead.

Run the Code — PWMexplore

19. Run the code by using the <F5> key, or using the Run button on the vertical toolbar, or
using Debug - Run on the menu bar. The top graph window should display two
PWM waveforms generated by the two BuckSingle macros.

20. In the watch window, the variable ConfigOption should be setto 1. This option or
case selects the BuckSingle macro (actually there are two of them) as the active wave-
form generator. Change the option to 2, and examine the waveforms for the BuckDual.

22
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Next, try the other options. Below is a list of the active PWM driver macro for each se-
lected ConfigOption:

BuckSingle (uses 2 single buck modules)
BuckDual
MPhIL (Multi-Phase Interleaved)

Ful IBridgePS (Phase-shifted full bridge)
FullBridgelBM (1BM method Full bridge)
PFC2PhIL (2 phase Interleaved PFC)

UL WNE

21. Select the BuckSingle again (ConfigOption = 1). Open sliders D1Slider,
D2Slider and TrigSlider by using GEL > PWM explore Sliders - and move
the sliders into the workspace area. The D1Slider and D2slider control the duty cycle of
each BuckSingle. The TrigSlider works by moving a trigger point similar to a trigger on
an oscilloscope, and permits the waveform to be viewed more conveniently. Note, when
adjusting the sliders the actual value in the watch window also changes. The value can
be changed by directly editing the watch window, but the slider position will not be up-
dated.

22. Next, select FullBridgePS (ConfigOption = 4). Open sliders PhaseSlider,
DbLSlider, and DbRSlider (GEL > PWM explore sliders->). The PhaseSlider
controls the phase relationship between the left and right legs of the full bridge. The
DbLslider and DbRSlider control the deadband of left leg and right leg, respectively.

23. Fully halting the DSP when in real-time mode is a two-step process. First, halt the proc-
essor by using Shift <F5>, or using the Hal t button on the vertical toolbar, or by using
Debug > Halt. Thenclick Debug - Real-time Mode and uncheck the
“Real-time mode” to take the DSP out of real-time mode.

24. If time permits, evaluate the other PWM macro drivers. The D1Slider is used to adjust
duty in ConfigOptions 3, 5, and 6. The LLdelSlider (left-leg delay) and LRdelSlider
(right-leg delay) is used to adjust the delay between bottom falling edge to top rising edge
for left and right full bridge legs, respectively in ConfigOption 5.

25. Close Code Composer Studio and turn off the power (SW1) to the 2-channel buck EVM.

End of Exercise
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2 — Driving the Power Stage with PWM Waveforms

Driving the Power Stage with PWM Waveforms

¢ Open-Loop System Block Diagram

¢ Generating PWM using the ePWM
Module

¢ Power Stage Topologies and
Software Library Support

Open-Loop System Block Diagram

Simple Open-Loop Diagram

Single Power Stage
HR
BUCK
DRV

Vinl Vout1

ST ZsTOm

Dutyl —» In — EPWMnA

ADC
1CH
DRV

s oo>»

Voutl —<«— Rstt [« Cho
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Generating PWM using the ePWM Module
Scaleable PWM Peripherals

Each peripheral module has the same structure

pravep—
[ SYNCI .
[E————— L epwnaro —»] O Resources allocated on a per channel basis
EPWML
™7 Module |- rwanso ——] Q Each channel (module) supports 2
seo [ independent PWM outputs (A&B)
oo 1wl
B QO # Channels easily scaleable — software reuse
RN Eoave [ EPMRRO QO Time-base synch feature for all channels
PIE| [ —emes0o Module | cougso | o] GPIO
Mux O 6 modules (12 PWM outputs) on F2808
o _ <4 Q Key features:
: QOPhase & edge control
e ONew counting modes
[ EPwwenT [ EPuwero — - Uindependent deadband
| |— EPWMSOC — EPWM6 . .
Module = epvieo —-»1 QFlexible trip-zones
g TZIn 10 1260 .
soc stheo o [ L UHigh frequency chopper mode
| ¥S0C — ]
o

to ECAP1module (sync in) _

ePWM Module Block Diagram

Time-Base (TB)

sync
— cTr=zero —3| InjOut

Select EPWMXSYNCO —»
— crrecwps —»| Mux *

TBPRD Shadow (16)

TBPRD Active (16)

— oisabled —» 5o g3

cTR=PRD
TBCTUSYNCOSEL)
J-L e — EPWMxSYNC|I ——
Counter 1 TBCTLISWFSYNC]
UP 1DWN TBCTLICNTLDE] Goftware forced syn)
(16 bit)
TBCNT CTR=ZERO
Active (16) G o
16
TBPHS A s =
ctive (16) | SIS — cTr=PrD —>
ontre - EPWMXINTD ——p
—crrezeno —l oo
— CTR=CMPA —3] Trigger & | EPWMXSOCA —pm
Interrupt
Counter Compare (CC) — ctrecurs —p  (ET)
|- EPWMXxSOCB ——fm
— crroor —>
crr=cupa ]
Action
Qualifier
(AQ)
CMPA Active (16) AR EPWMXAO —»' I
CMPA Shadow (16) - bW Trip
Band Chopper Zone
(DB) (PC) (TZ)

CcTR=CMPE {-oe]

EPWME epwmxso —m["]

~—— EPWMATZINTN
|— 210 0 Tzen =]
R —

CMPB Active (16)
CMPB Shadow (16)
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TBCTR
FFFFh
As Master Module
= 600 600
Master ,r TBPRD
Phase Reg En_ Syncin
L epwniia
CNT=Zero
CNT=CMPB —@ |- EPWMIB —p» 0000
() SyncO CTR=Ze
yncOut =Zero
(SyenOut) H ﬂ ﬂ .
: time
TBCTR !
FFFFh I D2 i
t¢——»i Phase = 120°
»v Slave Module : :
Slave + TBPRD 600 600
PhascReg  &n  Syncin
b EPWM2A 200 200
CNT-Zero—@ TBPHS
CNT-CMPE—@ L EPWM2B —p 0000 : :
SyncOut ! 1
£7 SyncIn n n =
time
Key Features TBCTR = Period L
O Multi event driven waveform generator TBCTR = Zero —=—p»| Action —® EPWMA
i i ualifier
O Events drive outputs Aand B |n.dependently. TBCTR = Compare A I ?/I o
Q Full control on waveform polarity I odule
A TBCTR = Ci B — —
O Fulltransparency on waveform construction ompare (AQ) EPWMB
QO S/W forcing events supported SW force ———
O All events can generate interrupts & ADC SOC T
TBCTR Direction
Actions
Events
Nothing | Clear Lo Set Hi Toggle
Zero TBCTR
(ZRO) A
ICA|
TBCTR C(MF:)A Period

(Up)
equals: | CMPB
(CBu)

CMPB

Period CMPA
(PRD)
CMPA Zero
TBCTR (CAd)
(Down)

equals: | CMPB
(CBd)

S/W force X
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Simple Waveform Construction
TTTTT trscm

e

HA T R B R

EPWMA

32 B 8 GR BB G

ATBCTR

rrrrr
vvvvv

EPWMB

Vin Vout1l
‘2808 a
—_— o p=d ) 11] —>
EPWM1A |—> Iin | T i Il
EPWM2A Iin | I j EPWM1A Buck #1 I
[ {.I
121 |eShuoun I <1 i = i = =
aza cL2 2 ! ! Vout2
CcL1 [ <« I i i 1—!- -
zs 3 1 Actionon j T 1 12
! !
EPWMIB |—AAA— :Se[CU Fau s | EPWM2A Buck #2
EPWM2B | AANA, secL2 ) 1 — =
I Lo
EcAPL | —AAN -.L’”w
==I A
~ J__; Q__L 1 b lisp e
Trip Zones: ———— Lty =+=
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One-time trip = catastrophic failure  —H
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Power Stage Topologies and Software Library Support

Multi-Phase Interleaved (MPI)

Master

opti

Ext Syncin
ional

CNT-Zero
CNT=CMPB—@ \
@ x

PhaseReg  gn_ Syncin
SyncOut
A

L EPWMIA —p

f—~ EPWM1B —p

Slave

@ = 1200
CNT-Zero—@
CNT-CMPB—@
Xx—0

PhaseReg  En  Syncln

f— EPWM2A —p-

[~ EPWM2B —p

Slave

CNT=Zero—@
CNT=CMPB—@

Xx—=0

PhaseReg  gn  Syncin

SyncOut

— EPWM3A —p

[~ EPWM3B —p»

v

Vin Q

EPWMI1A

EPWM1B

EPWM2A

£

EPWM2B

J Il}j

Vout
O

|
/1

13

Switching Requirements — MPI

EPWM2A

EPWM3A

» Asymmetrical PWM case

» Complementary output
generated by dead-band unit

* CMPB triggers ADC SOC

INIT-time

« Period (1,2,3)
* CAu Action (1,2,3)
« PRD Action (1,2,3)
* Phase (2,3)
« PRD Interrupt (1)
« CBu ADC SOC (1,2,3)
* Dead-band
RUN-time

« CMPA (1,2,3)
« CMPB (1,2,3)
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Half H-Bridge (HHB)

DC_bus our

Ext Sync In

(optional)
Master £ EPWMIA |H4
'_

Phase Reg En_ Syncin

y
~
m . |- EPWMIA —p 1 I
ONT=Zero
CNT=CMPB—@ \ |- EPWMIB -

Ay
/1

@ SyncOut

v EPWMIB 1 ~ i %
L - o

AY

Switching Requirements — HHB

CMPA CMPA
e rodation —*4— modation —— « Up/Down Count

e » Asymmetrical PWM
« dead-band on A only
* 50 % max Modulation

i
i .
v i ! :
1 : 1
. ! ; Z i (controlled by CMPA)
.
EPWM1B : : l : INIT-time
— L i = «ZROAction (AB)
z| cg [cA ; z A « CAd Action
i « CAu Action
-—P_DBRED [— I -—P_DBRED [-— ° CBd ADC trlgger
FpA : « CBd ADC trigger
* DBRED
Compare A modulation range:
0 < CMPA < ( PRD - % x DBRED ) RUN-time
* CMPA
* CMPB (optional)
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Phase Shifted Full Bridge (PSFB)

Ext Sync In

feptional)
Master ; ”
Phase Reg En_ Syncin
L spwia
CNT=Zero!
CNT=CMPB —@ [~ EPWMIB —p
x—®
SyncOut
A
Slave b
Phase Reg En  Syncln
L crunios
CNT=Zero—@
CNT=CMPB —@ [~ EPWM2B —p
SyncOut

Voo e Y Y Vour
\ 4 —o0
Jo
EPWMIA |'|: EPW@ i i
=

!
EPWMIB (4
—|

e

Switching Requirements — PSFB

;
[ ;
i

Vs

EPWM1A —
Pl v
transition
i Power ‘ ~
EPWM1B Phase | —i
] 1 3
| Vs
[ : transition
i
! ; > [ ®2=variable
] i
T
I
|

cecA
A *

EPWM2A J

EPWM28 Phase

i
4 AlY
|

=

FED

4

* Asymmetrical PWM

« Using dead-band module

 Phase (F) is the control variable

« Duty fixed at ~ 50%

* RED / FED control ZVS trans.
i.e. via resonance

* CMPB can trigger ADC SOC

INIT-time
« Period (1,2)
« CMPA (1,2) ~ 50%
« CAu action (1,2)
« ZRO action (1,2)
« CBu trigger for ADC SOC

RUN-time
* Phase (2) — every cycle
* FED / RED (1,2) — slow loop
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Software Driver Module — PSFB

0% duty
i i
- EPWMIA —> i ;

PSFB

=
DRV | P :
- EPwmis —> : - : -
— Netl —)p{ phase EPWMIA —» l._:
" — EPWM2A —» J » ‘ Leftleg
w

— Newz — legdb I EPwMB —>

, . _
— Net3 —{ rlegdb S I T ! ( >
i i
i
i
Vocma ez —
1
s by orwes | 3

EPWMMH Epwmﬂq 2 3

“Leftleg’ “Right leg’

L
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Lab2: PWM Generation / Open-Loop Control

» Objective

The objective of this lab exercise is to demonstrate the topics discussed in this module and control
the buck output voltage using simple PWM duty cycle adjustments without feedback. Since this
implementation is open-loop without a requirement for high speed feedback, the ADC will be
used to measure various values for instrumentation purposes and will be displayed using CCS.
The PWM duty cycle will be adjusted using watch windows or sliders. The Digital Power
software framework, associated files, and library modules will be used.

Lab2: PWM Generation / Open-Loop Control

¢ Control Buck output voltage using simple PWM
duty cycle adjustment without feedback

¢ Use CCS watch window and slider button features
to conveniently adjust PWM duty cycle

Buck
Single

Watch Window
DRV

I e
1
L Dutyl —pf

(— EPWM-1A

(— EPWM-2A

£ Z2Eom| [Ex Z=om

Watch Window

Dutyl Duty2
slider  slider

Voutl

Vout2

Temp1

Temp2

Ioutl

ADC
Casc
Seq
CNF

X oo>

Iout2

> Project Overview

Lab exercises 2, 3, and 4 use the TwoChannel project. It makes use of the “C-background/ASM-
ISR” framework. In Labl various PWM waveforms were generated using the EPWM modules 3,
4, and 5. The PWM outputs on the workshop EVM were not connected to power stages, but were
looped back as inputs to the ADC. In lab exercises 2, 3, and 4 EPWMSs 1 and 2 are used to drive
buck stages Channel 1 and Channel 2, respectively.

The key framework files used in this project are:

TwoChannel-Main.c - this file is used to initialize, run, and manage the application. This is
the “brains” behind the application.

TwoChannel-DevInit.c - this file is responsible for a one time initialization and
configuration of the F280x device, and includes functions such as setting up the clocks, PLL,
GPIO, etc.
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TwoChannel-1SR.asm - this file contains all time critical “control type” code. This file has
an initialization section that is executed one time by the C-callable assembly subroutine
_ISR_Init. The _ISR_Run routine executes at the same rate as the PWM timebase which is

used to trigger it.

The Power Library functions (modules) are “called” from this framework. Library modules may
have both a C and an assembly component. In this lab exercise, the following C and
corresponding assembly modules are used:

C configure function

ASM initialization macro

ASM Run time macro

BuckSingle CNFQ

BuckSingle DRV _INIT n

BuckSingle DRV n

ADC_CascSeqCNFQ

none

none

The workshop Power EVM consists of two identical buck power stages. The input bus voltage
for both stages is 12V. Shown below is a diagram of the Power EVM and some key features.

Main Pvir (SW1)

Load 1

Load 2
4

Active Load

12V In =—p
<+—DMM
DC Bus
(SW2)
V1/V2
# <+ Select
i CHE)
Buck 2 Buck 1 Comms
12V In DC power supply from plug pack
Main Pwr SW1 - Master power switch for entire EVM
DC Bus SW?2 - Power switch for Vin to buck stages only and when off F2808 DIMM
controller card still operates (next to the DC bus switch is a resettable fuse)
Buck 1, 2 Buck power stage modules with temperature/current measurement and over
current protection
Load 1, 2 Load terminals and/or buck converter output - next to each terminal block is a

light bulb or “visual” load (these draw approx 250 mA hot)
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Active Load

DMM

V1/V2 Select

Comms

Software controlled switched load (connected to output of buck 1 only)

Digital Multi-Meter (has a range of 0~20V, with resolution of 10 mV and is
used to measure output voltage of buck conterters)

SW3 - selects between output voltage of buck 1 and 2

Serial communications UART (optional for user, not used in lab exercises)

The key signal connections between the F2808 Digital Signal Controller and the 2 buck stages are
listed in the table below. For reference a portion of the shematic is also given.

Signal Name Description Connection to F2808
EPWM-1A PWM Duty control signal for buck stage 1 GPIO-00
EPWM-2A PWM Duty control signal for buck stage 2 GP10-02
VoutFB-1 Voltage feedback for buck stage 1 ADC-B0
VoutFB-2 Voltage feedback for buck stage 2 ADC-A0
lout-1 Current monitor / measurement buck stage 1 ADC-B1
lout-2 Current monitor / measurement buck stage 2 ADC-A1l
Temp-1 Temperature monitor / measurement buck stage 1 ADC-B2
Temp-2 Temperature monitor / measurement buck stage 2 ADC-A3
Ifault-1 Over-Current flag, digital output from buck stage 1 GPI10-01
Ifault-2 Over-Current flag, digital output from buck stage 2 GPI10-03
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» Lab Exercise Overview

The software in Lab2 has been configured to independently adjust the duty cycle of EPWM-1A
and EPWM-2A. “Net” variable names Duty1 and Duty2 have been declared and “connected”
to the inputs of BuckSingle DRV macro. Using either the watch window or the appropriate
slider, Duty1 and Duty2 can be directly adjusted. Below is the system diagram for Lab2.

E -
B.uCk P Vin Buck-1 Voutl
Watch Window Single |y
DRV | M
w
A [ Buck |2 = =
Single |
DRV | M s
- L . Buck-
Dutyl —» In H — EPWM-2A Vin Vout2
2 w 0—_|
Watch Window W
el
slider slider Vout2 ADC p (€ Vout2 — —L
Case | @F Tony: = =
«— Temp2
Seq | e Toutl
CNF Hle Tout2
Wl Vi

In Lab2 (as well as lab exercises 3 and 4) the assembly ISR _1SR_Run routine is triggered by
EPWML. This is where the BuckSingle_DRV macros are executed. Therefore, the PWM
update rate is equal to the PWM frequency. Since this system is running open-loop, there is not a
requirement for high speed feedback. As a result, the ADC function ADC_CascSeqCNF() is
called in the C background code during initialization, and the ADC measured values are only
used for instrumentation purposes. The update rate can be much slower with no need to be
synchronized to the PWM or ISR. The ADC values are read directly from the ADC result
registers (AdcMirror . ADCRESULTN) by the background C code.

A task state-machine has been implemented as part of the background code. Tasks are arranged
in groups (Al, A2, A3...,B1, B2, B3..., C1, C2, C3...). Each group is executed according to 3
CPU timers which are configured with periods of 1 ms, 4 ms, and 8 ms respectively. Within each
group (e.g. “B”) each task is run in a “round-robin” manner. For example, group B executes
every 4 ms, and there are 3 tasks in group B. Therefore, B1, B2, and B3 execute once every 12
ms. System dashboard measurements are conveniently done by group 3 tasks (i.e. B1 — voltage
measurement, B2 — current measurement, and B3 — temperature measurement).
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> Procedure

Open a CCS Project

1. Turn on the power (SW1) to the 2-channel buck EVM. Open Code Composer Studio and
maximize it to fill your screen.

2. A project named Lab2 . pjt has been created for this lab exercise. Open the project by
clicking:

Project - Open..
and look in C:\C28x_DPS\LABS\LAB2.

3. Load the TwoChannel .gel file by clicking:
File > Load Gel..

and look in C:\C28x_DPS\LABS\LAB2.

Device Initialization, Main, and ISR Files

Note: DO NOT make any changes to the source files — ONLY INSPECT

4. Open and inspect TwoChannel-DevInit.c by double clicking on the filename in the
project window. Confirm that GPIO00 and GPI002 are configured to be PWM outputs.

5. Open and inspect TwoChannel-Main.c. Notice the incremental build option 1 (i.e.
IB1). A section of code is shown here for convenience. Comments have been added in
italics. Note that the run-time macros are executed at the PWM rate of 300 kHz.

//

#if (1B1) // Open loop - Channels 1,2

//

#define prd 333 // Period count = 300 KHz @ 100 MHz
#define NumActvCh 2 // Number of Active Channels
// "Raw™ (R) ADC measurement name defines

#define VoutRl AdcMirror.ADCRESULTO //

#define VoutR2 AdcMirror.ADCRESULT1 //

#define loutR1 AdcMirror.ADCRESULT2 //

#define loutR2 AdcMirror.ADCRESULT3 //

#define TempR1 AdcMirror.ADCRESULT4 //

#define TempR2 AdcMirror.ADCRESULTS //

#define VinR AdcMirror _.ADCRESULT6 //

The ChSel array is used as input by function ADC_CascSeqCNF. These values will be used by “B” tasks for dashboard
calculations, and shown in the Watchwindow.
// Channel Selection for Cascaded Sequencer

ChSel[0] = 8; // BO - Voutl
ChSel[1] = O; // A0 - Vout2
ChSel[2] = 9; // Bl - loutl
ChSel[3] = 1; // Al - lout2
ChSel[4] = 10; // B2 - Temperature-1
ChSel[5] = 2; // A2 - Temperature-2
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ChSel[6] = 11; // B3 - Vin

The 3 configuration functions below are part of the Power Library.

BuckSingle_CNF(1, prd, 1, 0); // ePWM1, Period=prd, Master, Phase=Don"t Care
BuckSingle_CNF(2, prd, 0, 0); // ePWM2, Period=prd, Slave, Phase=0
ADC_CascSeqCNF(Chsel, 2, 7, 1); // ACQPS=2, #Conv=7, Mode=Continuous
EPwm1lRegs.CMPB = 2; // ISR trigger point

ISR_INnit(); // ASM ISR init

Dutyl and Duty2 variables will directly control the buck duty cycle. Sliders will be used to quickly change these values
Dutyl = OxO;
Duty2 = OxO;

// Module connection to ""nets" done here

// BUCK_DRV connections
Buck_Inl = &Dutyl;
Buck_In2 = &Duty2;
#endif // (1B1)

6. Open and inspect TwoChannel-1SR._asm. Noticethe ISR_Initand _ISR_Run

7.

sections. This is where the PWM driver macro instantiation is done for initialization and
run-time, respectively. The code is shown below for convenience. In Lab2, incremental
build option IB1 is used.

-if(1B1) ; Init time

BuckSingle_DRV_INIT 1 ; EPWM1A
BuckSingle_DRV_INIT 2 ; EPWM2A
.endif
-if(1B1) ; Run time
BuckSingle_DRV 1 ; EPWM1A
BuckSingle DRV 2 ; EPWM2A

.endif

Optionally, you can close the inspected files.

Build and Load the Project

8.

Click the ““Rebui Id Al1’" button and watch the tools run in the build window. The
output file should automatically load.

Under Debug on the menu bar click “Reset CPU”’, “Restart”, and then “Go
Main’. You should now be at the start of Main().

Setup Watch Window

10. Open the watch window to view the variables used in the project.

Click: View = Watch Window on the menu bar.

Click the “Watch 1” tab at the bottom of the watch window. In the empty box in the
"Name" column, type the symbol names from the following screen capture and be sure to
modify the “Type” and “Radix” as needed.

38
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2 Watch Window:

Marmne Walue Type | Radix |
@ VinMeas |00 | lang | gvalue(15]
@ Wmeas[1] |00 | lang | gvalue(15]
@ Wmeas[2] |00 | lang | gvalue(15]
o Imeaz[1] | 0o | long | gwalue15]
@ Imeaz[2] | 0.0 | long | gwalue(15]
& TdegC[1] | 250 | long | gwalue(15]
& TdegC[Z] | 25.0 | long | gwalue(15]
& Dty |0 | int16 | dec
& Duty2 |0 | int16 | dec

e .
&, atch Locals 37 Watch 1

The following table gives a description for the variable names:

Variable

Description

VinMeas

Voltage input measurement (i.e. DC bus) to each buck power stage

Vmeas

Voltage output of each channel, 3 element array, zeroth element not used

Imeas

Current output of each channel, 3 element array, zeroth element not used

TdegC

Temperature of each power module, 3 element array, zeroth element not used

Dutyl

Q15 value (0~7FFFh) for duty input to BuckSingle DRV1

Duty2

Q15 value (0~7FFFh) for duty input to BuckSingle_DRV2

Note 7FFFh = 32,768 = 100% duty

Save the Workspace

11. Save the

current workspace by naming it Lab2 .wks and clicking:

File > Workspace -> Save Workspace As..

and saving in C:\C28x_DPS\LABS\LAB2.

Run the Code — TwoChannel

12. Enable real-time mode by selecting:

Debug

- Real-time Mode

13. A message box may appear. If so, select YES to enable debug events. This will set bit 1
(DGBM bhit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit.
When the DGBM bit is set to “0”, memory and register values can be passed to the host
processor for updating the debugger windows.
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14. Check to see if the windows are set to continuously refresh. Click:

15.

16.

17.

18.

19.

20.

21.

22.

23.

View > Real-time Refresh Options..

and check “Global Continuous Refresh”.

Run the code by using the <F5> key, or using the Run button on the vertical toolbar, or
using Debug -> Run on the menu bar.

Note that in the watch window all values should be ~ zero, except for temperature, which
should be approximately equal to room temperature of 25° C.

Turn on the 12-volt DC bus (SW2) on the 2-channel buck EVM and observe variable
VinMeas in the watch-window. It should now be approximately 12V.

Open sliders D1Slider and D2Slider by using GEL - 2-Channel Sliders - and
move the sliders into the workspace area. D1Slider and D2Slider are used to change
variables Dutyl1 and Duty?2, respectively. Increase the value of Duty1 to approximately
2800 (decimal). Power stage buck 1 module output voltage should be approximately 1V
on the DMM. Be sure that SW3 on the EVM is positioned to select Chl. With the load
resistor (1) connected to terminal 1, the open-loop voltage for Channel 1 is
approximately given by:

1V | 2800
2V | 5600
3V | 8400

Try the same adjustment on Duty2. Be sure SW3 on the EVM is positioned to select
Ch2. Note that Channel 2 buck is only lightly loaded with a lamp (2~3Q) and hence a
slightly lower Duty?2 value will give the same output voltage as in the Ch1 case.

Of general interest — during duty/voltage adjustments observe the various watch window
variables such as voltage, current and temperature. VVmeas should reflect approximately
the same value as the DMM display. The current measurement is not very precise as it is
designed to measure a range up to 15A. Hence at low current levels accuracy will be
quite poor. Temperature should track quite well and the channel supplying the most
power will show an observable temperature increase.

Turn off the 12-volt DC bus (SW2) on the 2-channel buck EVM. (Do not turn off the
main power SW1).

Fully halt the DSP in real-time mode. First, halt the processor by using Shift <F5>, or
using the Hal t button on the vertical toolbar, or by using Debug -> Halt. Then click
Debug - Real-time Mode and uncheck the “Real-time mode” to take the
DSP out of real-time mode.

In the project window right click on Lab2 . pjt and select Close.
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24. Do Not Close Code Composer Studio or it will be necessary to setup the debug
environment windows again for the next lab exercise!

End of Exercise
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3 — Controlling the Power Stage with Feedback

Controlling the Power Stage with Feedback

Closed-Loop System Block Diagram
Analog-to-Digital Converter Module
Digital Control of Power Converter
High Resolution PWM Benefits

Soft Start — Starting the Loop

® ¢ 6 0 o

Closed-Loop System Block Diagram
The “Closed-Loop”

Control “PWM”
3 2P22” D RV

Duty
Vset ——— > Ref Uout |y .

—>a
—>-a
—>

ST Z2T=s7om

Vout

Vin
[ ]
gl <}::> B Power
-.—’ Stage 2
@ DRV p— :
DRV —a
Feedback :
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< Rslt

ST oOU>»
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ADC Module Block Diagram
ADC Module Block Diagram

Analog MUX

ADCINA0 —
ADCINA]'_’MUX S/H Result MUX

: A A RESULTO
ADCINA7 — 12-bit A/D RESULT1

i s

ADCINBO —] Converter | :
ADCINBL —MUX S/H Result :

: B soc| jEoc Select RESULT15
ADCINB7 —| Autosequencer

1—‘ MAX_CONV1

Ch Sel (CONV00)
Ch Sel (CONV01)
Ch Sel (CONV02)

Software Ch Sel (CONVO03)
ePWM_SOC_A 5
ePWM_SOC_B -

External Pin Ch Sel (CONV15)
(GPIO/XINT2_ADCSOC) Start Sequence
Trigger

Digital Control of Power Converter

Digital Control of Power Converter

Power Converter —— Vo
Vin = N _’|_ _,_

L * [T [
_l_ =Vo max - Kd

avsl |

Digital E
Controller u(n) E(n)
:

U(z) B,+Bz'+B,z7

S T 1A A

U(n)=B,E(n)+BE(n-1)+B,E(n-2)+ AU(n-1)+ AU (n-2)
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Digital Control of Power Converter

Steady State Limit Cycle

Vo levels (DPWM d —
.( WY ADC levels [error bins |
ratio steps) . J
Volt N
$Avs  +0010
= _ A $avs +0001
Vref BN 74 v e 0000
S S AL -0001

“steady state output, ~
~limitcycle " time

Vo Ievels_ (DPWM dUty ADC levels [m\‘
ratio steps) 3
Volts AVc RN
4Avs  +0010
——— $AVs  +0001
Vref =ra——----- 0000
A -0001
~ steady state output;
- nolimiteycle — time

High Frequency PWM

AV

- TPWM E—

PWM

TSyscIk

| PWM resolution = Log, ( Tpyy / Tsyscnc) |

F2808 — SysClk = 100 MHz

PWM Freq Regular resolution High resolution
(kHz) (bits) (%) (bits) (%)
100 10.0 0.1 16.0 0.002
150 9.4 0.2 15.4 0.002
250 8.6 0.3 14.7 0.004
500 7.6 0.5 13.7 0.008
750 7.1 0.8 13.1 0.011
1000 6.6 1.0 12.7 0.015
1500 6.1 1.5 12.1 0.023
2000 5.6 2.0 11.7 0.030
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High Resolution PWM (HRPWM)

P PWM Period R
Regular
Device Clock  MMUMUUULTUULUULUULTUULUULUULTUUIUULT PWM Step
(:e-200MH2) 1| || R L EFRE LT T e 20ns)
HRPWM divides a clock ,,..«-'“""'M' ...h“""""-»-....ﬂ_ Calibration Logic tracks the
cycle into smaller steps _m ...... _._._.:Lnumber of Micro Steps per
called Micro Steps clock to account for
(Step Size ~= 150ps) | Calibration Logic | variations caused by
Temp/Volt/Process
| HRPWM

LEREEREERREETEEEEETEET T Micro Step (~150ps)

¢ Significantly increases the resolution of conventionally derived digital PWM

¢ Uses 8-bit extensions to Compare registers (CMPxHR) and Phase register
(TBPHSHR) for edge positioning control

¢ Typically used when PWM resolution falls below ~9-10 bits which occurs at
frequencies greater than ~200 kHz (with system clock of 100 MHz)

¢ Not all ePWM outputs support HRPWM feature (see device data manual)

Resolution Loss — Low Duty Utilization

<
<

Y

TPWM

1
«—— Max Duty —¥»
i

PWM Not Utilized |—

_>| :4_
TsvyscL @ons)

t

0.8 1 1.2 1.8 25 3.3 5

Vin
14 94% 93% 91% 87% 82% 76% 64%
12 93% 92% 90% 85% 79% 73% 58%
10 92% 90% 88% 82% 75% 67% 50%
9 91% 89% 87% 80% 72% 63% 44%
8 90% 88% 85% 78% 69% 59% 38%
7 89% 86% 83% 74% 64% 53% 29%
6 87% 83% 80% 70% 58% 45% 17%
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High-Resolution PWM Benefits
Benefit of High Resolution PWM
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Simple User Interface Control
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Lab3: Closed-Loop Control
» Objective

The objective of this lab exercise is to demonstrate the topics discussed in this module and
regulate the output voltage of a buck power stage using closed-loop feedback control realized in
the form of a software coded loop. Soft-start and shut-down management will be explored using
the CCS watch window and sliders. ADC management for high-speed feedback and slow
instrumentation will be utilized. The Digital Power software framework, associated files, and
library modules will be used.

Lab3: Closed-Loop Control

¢ Regulate the Buck output by using Voltage Mode Control (VMC) with
closed-loop feedback

¢ Soft-start and sequencing function used to ensure an “orderly”
voltage ramp-up/down

¢ Soft-start profile and target voltage is conveniently adjusted by using
the CCS watch window and slider buttons feature

SStartSEQ

Single Power Stage

. Voltage HR 5
ﬂ Controller BUCK | w
CNTL M
——>| Delay 2P2Z PRV
H
Slope out p—— Vref —»|Ref Uout—>— Duty1 —» Duty w
Target FB
ADC | A
ICH |2
DRV
Watch Window o
Voutl —<—rsit0 w
e W
eron vindor
Mem
Buffer

Vsoft
slider

> Project Overview

The following Power Library modules will be used in this lab exercise. (Note: these are the same
library modules used in Lab2 exercise with the addition of other library modules).

C configure function ASM initialization macro ASM Run time macro

BuckSingle CNFQ) BuckSingleHR_DRV_INIT n | BuckSingleHR_DRV n

ADC_DualSeqCNF(Q) ADC_NChDRV_INIT n ADC_NchDRV n
none ControlLaw_2P2Z INIT n ControlLaw_2P2Z n
none DatalLogTST_INIT n DatalLogTST n
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Below is a description and notes for the Power Library modules used in this lab exercise.

BuckSingleHR_DRV

This is the high resolution PWM version of BuckSingle used in Lab2.
The C configure function (BuckSingle_CNF) is applicable for both
high-resolution and non-high-resolution versions of macro.

ADC_NchDRV

Reads 1* N ADC result registers every PWM cycle and stores to N
consecutive memory locations accessible by C. In Lab3, N=1 (i.e. a
single voltage is measured as feedback).

ControlLaw_2P2Z

This is a 2™ order compensator realized from an IIR filter structure.
The 5 coefficients needed for this function are declared in the C
background loop as an array of longs. This function is independent of
any peripherals and therefore does not require a CNF function call.

DatalLogTST

Data logging function with time-stamp trigger input. Although not
needed in the application itself, it provides a convenient way to
visualize the output voltage in a CCS graph window. In Lab4 the data
logger will be useful in displaying an output voltage transient.

Lab Exercise Overview

The software in Lab3 has been configured to provide closed-loop voltage control for Channel 1 of
the buck EVM. Additionally, datalogging of the output can be displayed in a CCS graph
window. Below is the system diagram for Lab3.

- EPWM1A B“Ck I

Vinl Voutl

Single Power Stage

J

SStartSEQ
— Buck | E
- i P
w Single W
CNTL HR 1l
» Delay 2P2Z DRV
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DRV
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Buffer -
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The closed-loop consists of only three modules — ADC_1ChDRV, CNTL_2P2Z, and
BuckSingleHR_DRV. When the code is runing these modules execute as in-line code (no
decision making) within the 1 SR_Run routine which is triggered at the PWM rate. To ensure
proper operation, Vref is kept at zero until a request is received to enable the output voltage. It is
important for a power supply to have a proper start-up and shut-down routine. This is managed
by the soft-start and sequencing code which executes in the main background C code
TwoChannel-Main.c. This code ensures that VVref can never have a step change, as direct
modification of Vref is not allowed. Vref can only be adjusted indirectly via a target value
request. This value will be reached at a given slew-rate. The slew-rate is programmable with
delay-on and delay-off time parameters which are useful for staggered sequencing of multiple
voltage rails.

In Lab3, the target voltage, slew-rate and delay-on/off parameters are conveniently modified via a
watch window. A slider can also be used to adjust the output target voltage by “connecting” it to
the Vsoft variable. The soft-start and sequencing code is “scaleable” and can manage multiple
voltage rails, for example 2, 3,...10 or more Vrefs. The interface to this code is via several
integer arrays and integer flags. The array index “n” is used to designate the channel number (i.e.
n=1 for channel 1, n=2 for channel 2,...etc.) Although in C an index of n=0 is valid, it is not used
here. Below is a summary of the arrays and their usage.

Desired output target voltage in Q15 format
Vsoft[n] e.g. Vsoft[2]=4000, set channel 2 output voltage to 4000 “units”

Enable (allow) voltage output to reach target value
e.g. ChannelEnable[3]=1, turn channel 3 “on”
e.g. ChannelEnable[2]=0, turn channel 2 “off”

ChannelEnable[n]

Step size or rate at which the target voltage is ramped to
e.g. SlewStep[2]=15, increment or decrement by 15 units at every
call

SlewStep[n]

Delay time to turn on from the “global” start command (StartUp=1)
e.g. OnDelay [3]=2000, start channel 3 after delay of 2000 “time
units”

OnDelay[n]

Delay time to turn off from the “global” stop command (StartUp=0)
e.g. OffDelay [3]1=1000, stop channel 3 after delay of 1000 “time
units”

OffDelay[n]

Global turn on/off command. Used to synchronize/sequence all
StartUp channels

e.g. StartUp=1, global turn on command
e.g. StartUp=0, global turn off command
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» Procedure

Open a CCS Project

1. Code Composer Studio should still be running from the previous lab exercise. If not,
then it will be necessary to setup the debug environment from the previous lab exercise.

2. A project named Lab3.pjt has been created for this lab exercise. Open the project by
clicking:

Project - Open..
and look in Cz\C28x_DPS\LABS\LABS3.

The TwoChannel.gel file and watch window should still be loaded from the previous lab.

Device Initialization, Main, and ISR Files

Note: DO NOT make any changes to the source files — ONLY INSPECT

3. Open and inspect TwoChannel-Main . c by double clicking on the filename in the
project window. Notice the incremental build option 2 (i.e. IB2). A section of code is
shown here for convenience. Comments have been added in italics.

/7
#if (IB2) // Closed Loop Ch-1, with SoftStart using separate lib blocks
//

#define prd 400 // Period count = 250 KHz @ 100 MHz
#define NumActvCh 1 // Number of Active Channels

// "Raw™ (R) ADC measurement name defines

#define VoutRl AdcMirror.ADCRESULTO //
#define VoutR2 AdcMirror.ADCRESULT8 //
#define loutR1 AdcMirror.ADCRESULT9 //
#define loutR2 AdcMirror.ADCRESULT10 //
#define TempR1 AdcMirror.ADCRESULT11 //
#define TempR2  AdcMirror.ADCRESULT12 /7/
#define VinR AdcMirror .ADCRESULT13 //

Soft-Start parameters for channel 1
OnDelay[1] = 0;
OffDelay[1] ;
Vsoft[1] = 10900; // 1.8 V
SlewStep[1] = 200;

Used for Scope feature via Graph window
DatalLogTrigger = 980000;

ScopeGain = 1;
ScopeACmode = O; // DC mode initially

ADC Sequencer 1 - VoutR1 used every PWM cycle
// Channel Selection for Sequencer-1
ChSel[0] = 8; // BO - Voutl

ADC Sequencer 2 — Instrumentation only, round robin scheme

// Channel Selection for Sequencer-2
Chsel[8] = 0O; // A0 - Vout2
ChSel[9] = 9; // Bl - loutl
ChSel[10] 1; // Al - lout2
ChSel[11] 10; // B2 - Temperature-1
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Chsel[12] = 2; // A2 - Temperature-2
ChSel[13] = 11; // B3 - Vin

PWM and ADC configure functions
BuckSingle CNF(1, prd, 1, 0); // ePWM1, Period=prd, Master, Phase=0
ADC_DualSeqCNF(ChSel, 1, 1, 1); // ACQPS=1, Seql#Conv=1, Seq2#Conv=1
EPwmlRegs.CMPB = 193; // tCMPB1 - ISR trigger point
ISR_InitQ; // ASM ISR init

// Lib Module connection to "nets"

// ADC1CH_DRV connections
ADC_Rslt = &Vfdbk;

// CNTL_2P2Z connections
CNTL_2P2Z_Refl = &VrefNetBus[1]; // point to Vref from SlewRate limiter
CNTL_2P2Z Outl = &Uout; // point to Uout

CNTL_2P2Z Fdbkl = &Vfdbk; // point to Vfdbk
CNTL_2P2Z_Coefl = &Coef2P2Z[0]; // point to first coeff for Single Loop

// BUCK_DRV connections
Buck_Inl = &Uout;

Datalogger is an optional feature, not required for loop to run

// Data Logger connections, DLTST = DatalLogTimeStampTrigger
DLTST_Inl = &Vfdbk;
DLTST_TimeBasel = &ECaplRegs.TSCTR;
DLTST_TimeStampTrigl = &DatalogTrigger;
DLTST_DcOffsetl = 0;
DLTST_Gainl = ScopeGain;

Compare B event setup to trigger both Sequencer 1 & 2 simultaneously, note: Seql has priority
// Trigger ADC SOCA & B from EPWM1

EPwm1lRegs.ETSEL.bit.SOCASEL = ET_CTRU_CMPB; // SOCA on CMPB event
EPwm1Regs.ETSEL.bit.SOCBSEL = ET_CTRU_CMPB; // SOCB on CMPB event
EPwm1lRegs.ETSEL.bit_.SOCAEN = 1; // Enable SOC on A group
EPwm1lRegs.ETSEL.bit.SOCBEN = 1; // Enable SOC on B group
EPwm1lRegs.ETPS.bit.SOCAPRD = ET_1ST; // Trigger on every event
EPwm1Regs.ETPS._bit.SOCBPRD = ET_1ST; // Trigger on every event

#endif // (1B2)

Open and inspect TwoChannel-1SR.asm. Noticethe ISR _Initand _ISR_Run
sections. This is where the PWM driver macro instantiation is done for initialization and
run-time, respectively. The code is shown below for convenience. In Lab3, incremental
build option IB2 is used. Note the order for the run time macros — 1) measure feedback,
2) compensate, 3) update PWM. Also, the ADC is not run in continuous mode, but rather
in SOC trigger mode, and therefore needs to be reset every cycle.

.iT(1B2) ; Init time

ADC_NchDRV_INIT 1 ; 1 Channel, N=1
ControlLaw_2P2Z INIT 1
BuckSingleHR_DRV_INIT 1 ; EPWM1A
DatalLogTST_INIT 1 ; 1 Channel Data logger

-endif

-if(1B2) ; Run time
ADC_NchDRV 1 ; 1 Channel, N=1 (Measure)
ControlLaw_2P2Z 1 (Compensate)
BuckSingleHR_DRV 1 ; EPWM1A (Update)
DatalLogTST 1 ; 1 Channel Data logger

ADC_Reset:
MOVW DP,#ADCTRL2>>6 ; Reset ADC SEQ
MOV @ADCTRL2,#0x4101 ; RST_SEQ1=1, SOCA-SEQ1=1, SOCB-SEQ2=1

.endif
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5. Optionally, you can close the inspected files.

Build and Load the Project

6. Click the “Rebuild Al button and watch the tools run in the build window. The
output file should automatically load.

7. Under Debug on the menu bar click “Reset CPU”’, “Restart”, and then “Go
Main”. You should now be at the start of Main().

Setup Watch Window and Graph

8. Another watch window will be opened in addition to the one used in the previous lab
exercise. Open the watch window to view the variables used in the project.

Click: View - Watch Window on the menu bar.
Click the “Watch 1” tab at the bottom of the watch window. In the empty box in the

"Name" column, type the symbol names from the following screen capture and be sure to
modify the “Type” and “Radix” as needed.

= Watch Window

Mame | Walue Type | Fiadis |
@ ChannelEnable(1] | 0 | int1E | dec
% ChannglE nable(2] | 0 | int16 | dec
& Waoft[1] | a | int16 | dec
G Weoft2] | 0 | int16 | dec
@ OnDelay(1] | 0 | int16 | dec
@ OnDelap(2] | 0 | int16 | dec
& OffDelap(1] | a | int16 | dec
& OffDelap(2] | a | int16 | dec
@ SlewStep(] | 0 | int16 | dec
@ SlewStep[2] | 0 | int16 | dec
& Startlp | 0 | int16 | dec
% ScopelGain | a | int16 | dec
% ScopedCmode | 0 | int16 | dec
& Activeload | 0 | Uint16 | unsigned
2 I
52 latch Locals w

Note: ScopeGain, ScopeACmode, and ActiveLoad will be explained and used in the
next lab exercise.
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The following table gives a description for the variable names:

Variable Description

ChannelEnable Channel enable array

Vsoft Voltage target array

OnDelay DelayOn array

OffDelay DelayOff array

SlewStep Ramp step size array

StartUp Global turn-on/turn-off integer flag

9. Open and setup a time graph windows to plot the data log buffer (ADC result register).
Click: View > Graph -> Time/Frequency.. and set the following values:

Display Type

Graph Title

Start Address

Fage

Acguizition Buffer Size
Index [ncrement
Display Data Size
DSP Data Tupe
[-value

Sampling Rate [Hz)
Flot Data From
Left-zhifted Data Display
Autozcale

DC Walue

b a=irurn - alue
Aues Dizplay

Time Dizplay Unit
Statusz Bar Display

b agnitude Dizplay Scale
[ata Plot Style

Grid Style

Curzor Mode

= Graph Property Dialog

Single Time
Graphical Display
DLogBufferl
Data

00

1

00

16-bit zigned integer
1]

1

Left ta Right

Tes

0ff

1]

32000

0ff

3

0ff

Linear

Line

Zem Line

Mo Curgor

0K | Cancel| Help |

Save the Workspace

Select OK to save the graph options.

10. Save the current workspace by naming it Lab3.wks and clicking:
File > Workspace > Save Workspace As..

and saving in C:\C28x_DPS\LABS\LAB3.
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Run the Code — TwoChannel

11.

12.

13.

14.

15.

16.

17.

18.

19.

Enable real-time mode by selecting:

Debug > Real-time Mode

A message box may appear. If so, select YES to enable debug events. This will set bit 1
(DGBM bit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit.
When the DGBM bit is set to “0”, memory and register values can be passed to the host
processor for updating the debugger windows.

Check to see if the windows are set to continuously refresh. Click:
View - Real-time Refresh Options..

and check “Global Continuous Refresh”.

Run the code by using the <F5> key, or using the Run button on the vertical toolbar, or
using Debug -> Run on the menu bar.

Turn on the 12-volt DC bus (SW2) on the 2-channel buck EVM and observe variable
VinMeas in the watch-window. It should now be approximately 12V. Also the Graph
window should show a trace hovering at “0”.

In the watch window turn on Channel 1 output by setting ChannelEnable[1]=1.
Power stage buck 1 module output voltage should ramp quickly to ~1.8V (be sure that
SW3 on the EVM is positioned to select Ch1). Note that directly turning-on (enabling)
an individual channel ignores the OnDelay and OffDe lay parameters since
synchronization to a global trigger is not utilized.

Open slider V1softSlider (GEL > 2-Channel Sliders ->)and move the slider
into the workspace area. This slider is used to directly change Vsoft[1]. Increase the
value of Vsoft[1] to approximately 10900 (decimal). Power stage buck 1 module
output voltage should be approximately 1.8V. When you are done turn off Channel 1 by
setting ChannelEnable[1]=0.

Channel 1 can also be enabled by using the global turn-on flag — StartUp. In this case
OnDelay and OFfDelay parameters are used. Both of these delays are set to zero by
default, but can be modified via the watch-window. For example, modify these values as
follows:

OnDelay[1]=1000
OffDelay[1]=2000
StartUp=1

This will trigger a global turn on and Channel 1 will start ramping up after 1000 time
units. Using StartUp=0 will trigger a global turn off and Channel 1 will ramp down
after 2000 time units.

The ramp-up and ramp-down rates can also be modified. In this lab code, up and down
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20.

21.

22.
23.

rates are the same and set by parameter SlewStep[1] for channel 1. The default value
in Lab3 is 200 units per step. Change it to 40 in the watch window and see the result.
Follow these steps:

SlewStep[1]=40

ChannelEnable[1]=1 Output should ramp up at slower rate

ChannelEnable[1]=0 Output should ramp down at slower rate

Turn off the 12-volt DC bus (SW2) on the 2-channel buck EVM. (Do not turn off the
main power SW1).

Fully halt the DSP in real-time mode. First, halt the processor by using Shift <F5>, or
using the Hal t button on the vertical toolbar, or by using Debug > Halt. Then click
Debug > Real-time Mode and uncheck the ““Real-time mode” to take the
DSP out of real-time mode.

In the project window right click on Lab3.pjt and select Close.

Do Not Close Code Composer Studio or it will be necessary to setup the debug
environment windows again for the next lab exercise!

End of Exercise
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4 — Tuning the Loop for Good Transient Response

Tuning the Loop for Good Transient Response

¢ Digital Power Supply Control Theory

¢ Intuitive Loop Tuning —“Visually
without Math”

¢ Active Load Feature of the Power EVM
¢ Multi-Loop Control

Digital Power Supply Control Theory

The Digital Control System

Digital Processor
R G(s)
e(kT)

r(t) c®

Sensor

Advantages Considerations
* Immunity from environmental effects

. : » Sample rate
« Advanced control strategies possible

* Quantization

« Immunity from component errors « Ease of programming

« Improved noise immunity « Controller design
« Ability to modify and store control parameters « Cost

« Ability to implement digital communications
» System fault monitoring and diagnosis

« Data logging capability

* Ability to perform automated calibration

* Processor selection
* Requires data converters
* Numeric issues

C28x Digital Power Supply Workshop
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PID Control Review

u(t) =K pe(®)+K, fe®).dt+K 5 90

D dt

K
K | GC(S):KP+TI+KDS

Ge(s) Jég
e fect H@g—@}

de

¢ Proportional term controls loop gain

¢ Integral action increases low frequency gain and
reduces/eliminates steady state errors

¢ Derivative action adds phase lead which improves
stability and increases system bandwidth

dt

1 Kp = Proportional gain

i _ 1
! GC (s)= KC[HﬁJ’Td SJ

K, = Integral gain
K = Derivative gain

Usually written in “parallel” form:

i
—oéi Kp = K¢

K, = KclTi
Kp = KTy

¢ Performance of the control loop can be determined from the
output response to a step change in load

¢ We will adjust PID coefficients to minimise deviation from
steady state and settling time of the output voltage

Steady state

Peak deviation

Tuning the Step Response

Transient Response Plat

—  Acceptable error

Settling time

Tirme ()
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Intuitive Loop Tuning — “Visually without Math”

Loop Tuning — Good First Step

u(n)=B,E(n)+B,E(n-1)+B,E(n-2)+ AU(n-1)+AU(n-2)

E(n-1) E(n-2)
E(n) z* z*

Bo B, B, PRD-SF

S FJ(L.Q%_. Dut
uty
A, A
z* z?
u(n-2) — ey

PID — Intuitive / Interactive

We can also write the controller in transfer function form:

Compare with the General 2P2Z transfer function:

U(z) Bo+ Br*zl+ By*z?

E@ 1 +Arz'+Arz?

B()Z2 + B*z + B>

Z2 + A%z + Az

We can see that PIDis nothing but a special case of 2P2Z control where:
Ar=-1 and A= 0

Change PID coeff. “on fly” in back-ground loop

// Coefficient init

Coef2P27_1[0] = Dgain * 67108; /7 B2

Coef2P2Z_1[1] = (lgain - Pgain - Dgain - Dgain)*67108; // B1

Coef2P2Z_1[2] = (Pgain + lgain + Dgain)*67108; // BO

Coef2P2Z_1[3] = 0; 7/ A2

Coef2P2Z_1[4] = 67108864; /7 A1

Coef2P2Z_1[5] = Dmax[1] * 67108; /7 Clamp Hi limit (Q26)
Coef2P2Z_1[6] = 0x00000000; // Clamp Lo

C28x Digital Power Supply Workshop
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Control Law Computation

Uu()=B,E(n)+B,E(n-1)+B,E(n—-2)+ AU (n-1)+AU(n-2)

u(n)

DBUFF =

U(n-1)

U(n-2)

E(n)

E(n-1)

E(n-2)

XART7 b

i e(n)=Vref-Vout

MOVU
SUBU
LSL

MOVL
ZAPA

MOVL
QMPYAL
MOVDL
QMPYAL
MOVDL
QMPYAL
MOVL
QMPYAL
MOVDL
QMPYAL
ADDL
LSL
ADDL
MOVL

MINL
MAXL

MOVL
QMPYL
Mov

ACC, @Vref
ACC, *XAR2++
ACC, #8

@VCNTL_DBUFF+4,ACC

; Voltage control law
XT,@VCNTL_DBUFF+8 ; XT=e(n-2)

P, XT, *XAR7++

XT,@VCNTL_DBUFF+6 ; XT=e(n-1), e(n-2)=e(n-1

P, XT, *XAR7 ++

XT,@VCNTL_DBUFF+4 ; XT=e(n), e(n-1)=e(n)

P, XT, *XAR7++

XT,@VCNTL_DBUFF+2 ; XT=u(n-2)

P, XT, *XAR7 ++

XT,@VCNTL_DBUFF  ; XT=u(n-1), u(n-2)=u(n-1)

P,XT, *XART ++
acc, P

ACC, #(23-VCNTL_QF+8) i (Q23)

ACC, ACC
@VCNTL_DBUFF

ACC, *XAR7++
ACC, *XAR7++

i Duty Cycle Modulation

XT,ACC
P, XT, *XAR7++
*XAR3++, P

,ACC ; ACC=u(n)
; Saturate the result [min,max]

i ACC=e (n) (Q24)

; b2*e(n-2)

i ACC=b2*e(n-2), P=bl*e(n-1)
; ACC+=bl*e(n-1), P=bO*e(n)
; P=a2*u(n-2)

i ACC=a2*u (n-2)
; ACC=a2*u (n-2)+al*u(n-1)

i (Q24)

7 (Qo0)
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RC, st C +C,
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Active Load Feature of the Power EVM

2-Channel Buck EVM

Active Volt

Meter

TI PowerTrain Phase Links
PTDO8AO1OW
10A module

= Current meas.

= Temp meas

= Over Current Prot.

= Over Current Flag

* No Heat-sink needed

Tesas Instruments
2 Ch Buck EVH
F28fxx
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Lab4: Tuning the Loop

» Objective

The objective of this lab exercise is to demonstrate the topics discussed in this module and tune
the closed-loop buck power stage for improved transient performance using visual “trial and
error” methods rather than a mathematical approach. The transient response will be modified by
interactively adjusting the system proportional (P), integral (1), and derivative (D) gains using
sliders. An active load circuit enabled by software will provide a repetitive step change in load.
The CCS graph window feature will be used to view the transient response in real-time. The
Digital Power software framework, associated files, and library modules will be used.

Lab4: Tuning the Loop

¢  Tune closed-loop Buck power stage for improved transient performance
using visual “trial and error” (rather than mathematical approach)

¢ The 2-channel Buck EVM has an active load circuit when enabled by software
provides a repetitive step change in load

¢ CCS graph window feature used to view the transient in real-time

+ Transient response can be modified directly until the desired improvement is
achieved by adjusting P, |, D sliders Fault
Trip

: « ine”
Coefficient “tuning Dead

PID SSartSEQ Vset Band
L
a] /AN |
“PWM” —a
> Delay Control DRV |y
»>{ Slope  Out p—e “2P22” Duty D .
PID Clamp uty H| e
Mapping > Target Ref v In w| e
(3t05) out ———
Coeff set 3 —» FB
Coeff set 2 |

CCS or GUI Open/Closed

Coeff set 1

S0 Loop
shders OR [ coeff - B2 “ADC” | p l—am
| DRV |Cle—am
Coeff - B1
Tm Feedback o [
Pole / Zero | Coeff - BO ¢ Rsit w| a
‘l |—»] to Coef Map | Coeff - A2
(5to5) Ll Graph Window

° Coeff - A1
" Re DataLog

Mem
Buffer

In

Pole / Zero
adjust GUI

> Project Overview

The software code used in Lab4 is exactly the same code as used in Lab3. All of the files and
build options are identical. The five coefficients to be modified are stored in the array
Coef2P2Z[n]. Directly manipulating these five coefficients independently by trial and error is
almost impossible, and requires mathematical analysis and/or assistance from tools such as
matlab, mathcad, etc. These tools offer bode plot, root-locus and other features for determining
phase margin, gain margin, etc.

To keep loop tuning simple and without the need for complex mathematics or analysis tools, the
coefficient selection problem has been reduced from five degrees of freedom to three, by
conveniently mapping the more intuitive coefficient gains of P, I and D to B0, B1, B2, A1, and
A2. This allows P, | and D to be adjusted independently and gradually. This method requires a
periodic transient or disturbance to be present, and a means to observe it while interactively
making adjustments. The data-logging feature introduced in Lab3 provides a convenient way to
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observe the output transient while the built-in active load on the EVM can provide the periodic
disturbance.

The compensator block (macro) used is CNTL_2P2Z. This block has 2 poles and 2 zeros and is
based on the general IR filter structure. The transfer function is given by:

U(z) _ bo+biz ™t +b2z7
E(z) 1+aizt+acz?

The recursive form of the PID controller is given by the difference equation:

u(k)=u(k 1)+ boe(k )+ bae(k —1)+ be(k - 2)

where:
bo = Kp'+Ki'+Kd'
b1 = —Kp'+Ki'-2K4'
b2 = Kqd'

And the z-domain transfer funcion form of this is:

U(2) _botbiz" +boz? _ boz’ + bz +be
E(2) 1-z71 7227

Comparing this with the general form, we can see that PID is nothing but a special case of
CNTL_2P2Z control where:

aa=-1 and a2=0

In the lab exercise, you will inspect the C code in which these coefficients are initialized.

» Lab Exercise Overview
In Lab3 the software has been configured to provide closed-loop voltage control for Chl of the
buck EVM and datalogging of the output which was displayed in a CCS graph window. Lab4
will additionally allow modification of the five coefficients associated with the 2" order
CNTL_2P2Z compensator block. This modification will be done “on the fly” by using 3 sliders
(P, I and D) while the buck output is put under transient using an active load which is switched
periodically by the ECAP peripheral.

The following figure is the system diagram for Lab4.
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The default coefficient settings chosen for Lab3 provide very poor performance (low gains).
Initially Lab4 will use the same settings. The control loop will be soft-stared to the target Vout
value, the same way it was done in Lab3. At this point, the active load will be enabled and a load
resistor of equal value to the static load will be switched in and out periodically.

In addition to the watch window variables discussed in Lab3, a few others will be used in the loop
tuning process. These include the P, | and D gains, active load enable, and CCS graph window
(scope control). The table below summarises these new variables.

Pgain Proportional gain; value adjustment : 0 ~ 1000
Igain Integral gain; value adjustment : 0 ~ 1000
Dgain Derivative gain; value adjustment: 0 ~ 1000

ActivelLoad | Enable (value=1) / Disable (value=0) flag for the active load circuit

ScopeACmode | Sets the CCS Scope (graph window) to operate in AC mode (i.e. removing the
DC component) and is useful for zooming into the transient only

ScopeGain Vertical gain adjustment for the CCS scope (much like a real oscilloscope)
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» Procedure

Open a CCS Project

1. Code Composer Studio should still be running from the previous lab exercise. If not,
then it will be necessary to setup the debug environment from the previous lab exercise.

2. A project named Lab4 . pjt has been created for this lab exercise. Open the project by
clicking:

Project - Open..
and look in Cz\C28x_DPS\LABS\LABA4.

The TwoChannel.gel file, watch windows and graph window should still be loaded from
the previous lab.

Device Initialization, Main, and ISR Files

Note: DO NOT make any changes to the source files — ONLY INSPECT

3. Open and inspect TwoChannel-Main. c by double clicking on the filename in the
project window. This file is identical to the one used in Lab3. Notice the coefficient
initialization and P, 1, and D mapping equation. A section of code is shown here for
convenience.

Pgain = 1; lgain = 1; Dgain = 5; // very "loose"

// Coefficient init for Single Loop
Coef2P2Z[0] = Dgain * 67108; // B2
Coef2P2Z[1] = (lgain - Pgain - Dgain - Dgain)*67108; // Bl
Coef2P2Z[2] = (Pgain + lgain + Dgain)*67108; // BO
Coef2P2Z[3] = O; // A2
Coef2P2Z[4] = 67108864; // A1 =1 in Q26
Coef2P2Z[5] = Dmax[1] * 67108; // Clamp Hi limit (Q26)
Coef2P2Z[6] = 0x00000000; // Clamp Lo

(Note: 67108 = ~ 0.001 in Q26 format)

4. Optionally, you can close the inspected file.

Build and Load the Project

5. Click the ““Rebui Id Al button and watch the tools run in the build window. The
output file should automatically load.

6. Under Debug on the menu bar click “Reset CPU”’, “Restart”, and then “Go
Main’. You should now be at the start of Main().
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Save the Workspace

7.

The watch windows and graph window were setup in the previous lab exercise. A
workspace needs to be saved to include the project for this lab exercise. Save the current
workspace by naming it Lab4 _wks and clicking:

File > Workspace > Save Workspace As..

and saving in C:\C28x_DPS\LABS\LAB4.

Run the Code — TwoChannel

8.

10.

11.

12.

13.

14.

Enable real-time mode by selecting:

Debug -> Real-time Mode

A message box may appear. If so, select YES to enable debug events. This will set bit 1
(DGBM bit) of status register 1 (ST1) to a “0”. The DGBM is the debug enable mask bit.
When the DGBM bit is set to “0”, memory and register values can be passed to the host
processor for updating the debugger windows.

Check to see if the windows are set to continuously refresh. Click:
View > Real-time Refresh Options..

and check “Global Continuous Refresh”.

Run the code by using the <F5> key, or using the Run button on the vertical toolbar, or
using Debug -> Run on the menu bar.

Turn on the 12-volt DC bus (SW2) on the 2-channel buck EVM and observe variable
VinMeas in the watch-window. It should now be approximately 12V. Also the Graph
window should show a trace hovering at “0V”.

In the watch window turn on Channel 1 output by setting ChannelEnable[1]=1.
Power stage buck 1 module output voltage should ramp quickly to ~1.8V (be sure that
SW3 on the EVM is positioned to select Ch1l).

Enable the active load circuit by setting variable ActiveLoad = 1 inthe watch
window. To better view only the transient or AC component of the output voltage, set
the graph to AC mode by changing variable ScopeACmode = 1. This should put the
output waveform at the graph “zero” line. Optionally, set the scope gain higher by
changing variable ScopeGain = 4. If lab is working correctly, then the graph
window should look something like the following:
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15.

16.

B Graphical Display

=10jx|
2

T "7L

The negative going transient is when the extra load is switched in and the positive going
overshoot is when the extra load is removed.

Open the sliders for P, I and D adjustment (GEL - 2-Channel Sliders -)
Pgain_Slider, Igain_Slider and Dgain_Slider. Optionally, if you want to adjust the output
voltage via a slider, then open VsoftSlider, too. Move the sliders into the workspace
area.

By observing the transient in real time, gradually adjust each slider to get the best
transient response (i.e. least pertubation from the zero line). Gradual adjustment can be
best achieved by selecting the slider (mouse click) and then using the up/down arrows. A
large movement of the slider may cause the system to go unstable. A suggested
procedure is given below:

e Start with lgain first, increase gradually until the negative going transient flattens
out near the zero line

Increase Pgain until some oscillation (2~3 cycles) occurs

Increase Dgain to remove some of the oscillation

Increase Igain again

keep iterating very gradually until an acceptable transient is achieved — this may
look something like the graph shown below:

(=[5}
=
') i
w fin A v L=t K il i e T
i b
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17. Reduce the scope vertical gain back to 1 (ScopeGain = 1) and set the graph back in
DC mode (ScopeACmode = 0). The voltage output response should look something

like this now:
[mencanmy ETE
A
A A
AV
£l "J/.n

18. With the active load still enabled, try shutting down Channel 1 output and then bringing it
back up under “soft” shut-down and start-up conditions. The closed loop should be
stable during the ramping even during the switching transients.

19. Turn off the 12-volt DC bus (SW2) on the 2-channel buck EVM. (Do not turn off the
main power SW1).

20. Fully halt the DSP in real-time mode. First, halt the processor by using Shift <F5>, or
using the Hal t button on the vertical toolbar, or by using Debug -> Halt. Then click
Debug > Real-time Mode and uncheck the ““Real-time mode” to take the
DSP out of real-time mode.

21. Close Code Composer Studio and turn off the power (SW1) to the 2-channel buck EVM.

End of Exercise
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Multi-Loop Control
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DC-DC (ZVSFB) Software Control Flow
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5 — Summary and Conclusion

Summary and Conclusion

¢ Review of Workshop Topics and
Exercises

¢ TI Digital Power Products

+ C2000 Digital Signal Controller
Family

+ UCD9xxx Digital Power Controller
Family

¢ Where to Find More Information

Review of Workshop Topics and Exercises

Workshop Topics and Exercises Review

¢ C28x DSC family provides ideal controller
for Digital Power Supply design

+ Scalable ePWM peripherals, ADC and fault
management support

+ Code Composer Studio, DPS Library and TI
Buck EVM

¢ Controlled Buck output voltage using
PWM waveform and duty cycle without
feedback

¢ Controlled Buck output using Voltage
Mode Control with feedback

¢ Tuned closed-loop Buck power stage
visually using CCS features
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Tl Digital Power Products

Tl Is The Right Digital Power Partner

Tl solutions cover the spectrum of power applications

p

Flexibility

/@SZOFZSZX
i n

T

) ’\)
*\ — 13X
“S(Tms320r280x

. 1lly Programmable,
control Focused
L uc 220
& UCD9240 Power-Optimized
Controllers

_—

System Complexity

TI's Digital Power Solutions Span the
Industry

Non-Isolated DC/DC POL

« UCD91xx Single-Output Digital Controller
* UCD92xx Multi-Output Digital Controller
* TMS320C2000 Digital Signal Controllers

Isolated DC/DC &
Offline AC/DC

» TMS320C2000 Digital Signal Controllers

DC/AC Inverters

* TMS320C2000 32-bit controller
solutions for green energy (solar, wind,
fuel cells) and UPS battery backup

System Management

Only

» UCD9080 Power Supply Sequencer
and Monitor
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C2000 Digital Signal Controller Family
C2000 Family Roadmap

300 MFLOPS
FPU, DMA

uture
28X XX

High Performance Signal Processing
= Up to 100 MHz performance

= Single cycle 32 x32-bit MAC (or dual 16 x16 MAC)
= Very Fast Interrupt Response

= Single cycle read-modify-write

Memory Sub-System

Fast program execution out of both RAM and
Flash memory

= 80 MIPS with Flash Acceleration Technology

= 100 MIPS out of RAM for time-critical code
Control Peripherals

Up to 16 PWM channels and 4 event captures

150 ps High-Resolution PWM

Ultra-Fast 12-bit ADC

= 6.25 MSPS throughput

= Dual sample&holds enable simultaneous sampling

RealTime = Auto Sequencer, up to 16 conversions w/o CPU
m ile Communications Ports

Multiple standard communication ports provide
simple interfaces to other components

Datasheet available at: http://www-s.ti.com/sc/ds/tms320f2808.pdf
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F280xx Controller Portfolio

All Devices are 100% Hardware, Software & Pin Compatible

F28015 60 32 12 267ns 10/4 2/0 SPI, SCI, I’C
F28016 60 32 12 267ns 10/4 2/0 SPI, SCI, CAN, I’C
F2801-60 60 32 12 267ns 8/3 2/1 2x SPI, SCI, CAN, I>C
F2802-60 60 64 12 267ns 8/3 2/1 2x SPI, SCI, CAN, I’C
F2801 100 32 12 160ns 8/3 2/1 2x SPI, SCI, CAN, I’C
F2802 100 64 12 160ns 8/3 2/1 2x SPI, SCI, CAN, I’C
F2806 100 64 20 160ns 16/4 4/2 4x SPI, 2x SCI, CAN, I°C
F2808 100 128 36 160ns 16/4 4/2 4x SPI, 2x SCI, 2x CAN, I>)C
F2809 100 256 36 80ns 16/6 4/2 4x SPI, 2x SCI, 2x CAN, I’C
F28044 100 128 20 80ns 16/16 0 SPI, SCI, I’C

100-pin LQFP and u*BGA,; Also available in -40 to 125 C and Automotive Q100

TMS320F283xx Digital Signal Controllers

High Performance Signal Processing

ity
128-512 = Up to 150 MHz performance with 32-bit floating-
52-68 . §
F:(Bh KB SKBt point unit
S RAM | RO% - Six-channel DMA speeds data throughput
[ j [ ] [ = Very Fast Interrupt Response

Memory Sub-System

Fast program execution out of both RAM and

Flash memory

= 120 MIPS with Flash Acceleration Technology

= 150 MIPS out of RAM for time-critical code
Control Peripherals

Up to 16 PWM channels and 4 event captures

150 ps High-Resolution PWM

Ultra-Fast 12-bit ADC

= 12.5 MSPS throughput

= Dual sample&holds enable simultaneous sampling

= Auto Sequencer, up to 16 conversions w/o CPU

U S

DMA
Interrupt Management —

—

sng elaydiiad

Floating-
Point Unit

Communications Ports
;I Multiple standard communication ports provide
simple interfaces to other components

Datasheet available at: http:/Aww-s.ti.com/sc/ds/tms320f28335.pdf
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F283xx & F282xx Controller Portfolio

SPI, 3x SCI, I°C,
F28335 150 Yes 512 68 80 ns Yes 18/6 6/2 2x McBSP, 2x
CAN

SPI, 3x SCI, I’C,
F28334 = 150 @ Yes 256 68 80 ns Yes 18/6 4/2 2x McBSP, 2x
CAN

SPI, 2x SCI, I°C,
F28332 =100 @ Yes 128 52 80 ns Yes 16/4 4/2 McBSP. 2x CAN
SPI, 3x SCI, I°C,
F28235 150 No 512 68 80 ns Yes 18/6 6/2 2x McBSP, 2x
CAN

SPI, 3x SCI, I°’C,
F28234 150 No 256 68 80 ns Yes 18/6 4/2 2x McBSP, 2x
CAN

SPI, 2x SCI, I?C,

F28232 100 No 128 52 80 ns Yes 16/4 4/2 McBSP, 2x CAN

« 176-pin/ball LQFP/PBGA; 179-ball u*BGA; -40 to 125 C and Q100 in PBGA
« IQMath library provides software compatibility between floating-point and
fixed-point!

C2000 controlCARDs

2808
only $59!

¢ New low cost single-board controllers perfect for initial
software development and small volume system builds.

¢ Small form factor (9cm x 2.5cm) with standard 100-pin DIMM
interface

¢ F28x analog I/O, digital I/O, and JTAG signals available at
DIMM interface

¢ |Isolated RS-232 interface
¢ Single 5V power supply required

¢ controlCARDs available for 100MHz fixed-point
TMS320F2808, TMS320F28044, and 150 MHz
TMS320F28335 floating-point controller

¢ controlCARDs are available individually through TI distributors
and on the web:

+ Part Number;: TMDSCNCD2808, TMDSCNCD28044,
TMDSCNCD28335
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Digital Power Experimenter Kit

¢ DPEK includes

+ 2-rail DC/DC EVM using TI
PowerTrain™ modules%lOA)

» On-board digital multi-meter and
active load for transient
response tuning

+ F2808 controlCARD

+ C2000 Applications Software CD
with example code and full
hardware details

« Digital Power Supply Workshop
teaching material and lab
software

+ Code Composer Studio v3.3 with
code size limit of 32KB

+ 9VDC power supply
¢ DPEK available through TI

authorized distributors and on
the web

+ Part Number:TMDSDCDC2KIT

2000 DC/DC Developer’s Kit

¢ DC/DC Kitincludes

+ 8-rail DC/DC EVM using TI
PowerTrain™ modules%lOA)

+ F28044 controlCARD

« C2000 Applications Software CD
with example code and full
hardware details

+ Code Composer Studio v3.3 with
code size limit of 32KB

+ 9VDC power supply

¢ Available through Tl
authorized distributors and on
the web

+ Part Number: TMDSDCDCSKIT
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C2000 AC/DC Developer’s Kit

¢ AC/DC Kitincludes

$695! + AC/DC EVM with interleaved PFC
and phase-shifted full-bridge

+ F2808 controlCARD

« C2000 Applications Software CD
with example code and full
hardware details

+ Code Composer Studio v3.3 with
code size limit of 32KB

¢ AC/DC EVM features
« 12VAC in, 80W/10A output
« Primary side control
« Synchronous rectification
« Peak current mode control

+ Two-phase PFC with current
balancing

¢ AC/DC Kit available through TI
auttr;orlzed distributors and on the
we

+ Part Number: TMDSACDCKIT

Emulation Solutions for C2000 Controllers

&

¢ BlackHawk USB2000 ¢ Spectrum Digital XDS510-LC
Controller only $299 only $249
+ Full CCS compatibility + Full CCS compatibility
+ Bi-Color Status LED + Supports SDFlash
(red/green) programming utility
+ 3.3/5.0 volt device I/O + Supports XMLGUI for
+ Optional Isolation Adaptor for interfacing to ‘C’ — provides
$299 scripting capability
¢ http:/www.blackhawk- ¢ http:/mwww.spectrumdigital.com

dsp.com/Resellers.aspx
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VisSim Graphical Programming
or C2000

Ty e
10 Ot ke ik i 1 S D NP o O IS e
¥

et ¢ Model based design for
D388 va o s I o o] simulation, code generation,
T and interactive debugging

J e Efficient code generation
near hand code quality

¢ Automatic code generation
for F28xx peripherals: ADC,
SCI, SPI, I?C, CAN, ePWM,
GPIO

¢ High speed target
acquisition for wave form
display on PC

- Watch ‘how to’ tutorials on
— Visual Solutions web site

Pl control of 1 DC Buck Voltage Converter @ 300 KHz

B 5 ey B0 o B

WWW.VISSim.com

UCD9xxx Digital Power Controller Family

UCD9xxx Digital Power Controller Family

)

4 ind outputs
64 & 80 pin

3 ind outputs
48 pin

2 ind outputs
4 32pin

Performance

1 output, 2 phase
32 pin

1 output, 1 phase
32 pin

Integration
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Where to Find More Information

Introduction to
TMS320F2808
Design and
Peripheral Training

Recommended Next Step:
One-day Training Course

TMS320C28x 1-Day Workshop Outline
- Workshop Introduction

- Architecture Overview

- Programming Development Environment
- Peripheral Register Header Files

- Reset, Interrupts and System Initialization
- Control Peripherals

- IQ Math Library and DSP/BIOS

- Flash Programming

- The Next Step...

In-depth
TMS320F2808
Design and
Peripheral Training

Recommended Next Step:
Multi-day Training Course

TMS320C28x Multi-day Workshop Qutline

- Architectural Overview

- Programming Development Environment
- Peripheral Register Header Files
- Reset and Interrupts

- System Initialization

- Analog-to-Digital Converter

- Control Peripherals

- Numerical Concepts and IQmath
- Using DSP/BIOS

- System Design

- Communications

- Support Resources
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For More Information . . .

Internet
Website: http://www.ti.com

FAQ: http://www-k.ext.ti.com/sc/technical_support/knowledgebase.htm

+ Device information ¢ my.ti.com
* Application notes . + News and events
+ Technical documentation ¢ Training

Enroll in Technical Training:  http://www.ti.com/sc/training

USA - Product Information Center ( PIC)
Phone: 800-477-8924 or 972-644-5580
Email: support@ti.com

+ Information and support for all TI Semiconductor products/tools
+ Submit suggestions and errata for tools, silicon and documents

European Product Information Center (EPIC)

Web: http://www-k.ext.ti.com/sc/technical support/pic/euro.htm

Phone: Language Number

Belgium (English) +32 (0) 27 45 55 32
France +33 (0) 1 30 70 11 64
Germany +49 (0) 8161 80 33 11
Israel (English) 1800 949 0107 (free phone)
Italy 800 79 11 37 (free phone)
Netherlands (English) +31 (0) 546 87 95 45
Spain +34 902 35 40 28
Sweden (English) +46 (0) 8587 555 22
United Kingdom +44 (0) 1604 66 33 99
Finland (English) +358(0) 9 25 17 39 48

Fax: All Languages +49 (0) 8161 80 2045

Email: epic@ti.com

¢ Literature, Sample Requests and Analog EVM Ordering

+ Information, Technical and Design support for all Catalog TI
Semiconductor products/tools

+ Submit suggestions and errata for tools, silicon and documents
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